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Preface

To continuously improve and enhance performance and capabilities, EMC periodically 
releases new versions of its hardware and software. Therefore, some functions may not be 
supported by all revisions of the software currently in use. For the most up-to-date 
information on product features, refer to the product release notes. 

Audience This guide is part of the NetWorker VSS Client for Microsoft Windows 
documentation set, and is intended for use by system administrators during the setup 
and maintenance of the product.

Readers should be familiar with the following topics:

◆ EMC NetWorker

◆ EMC NetWorker Snapshot management

◆ Microsoft Volume Shadow Copy Service (VSS) technology

Related
documentation

Related documents include:

◆ EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition 
Installation Guide

◆ EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Release 
Notes

◆ EMC NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide 

◆ EMC Software Compatibility Guide

◆ EMC Solutions Enabler documentation

Conventions EMC uses the following conventions:

Note: A note presents information that is important, but not hazard-related.

CAUTION

A caution note contains information that is essential to avoid data loss. 
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide 7
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Typographical conventions
EMC uses the following type style conventions in this document:

Where to get help EMC support, product, and licensing information can be obtained as follows.

Product information — For documentation, release notes, software updates, or for 
information about EMC products, licensing, and service, go to the EMC Powerlink 
website (registration required) at:

http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer Service on 
Powerlink. To open a service request through Powerlink, you must have a valid 
support agreement. Please contact your EMC sales representative for details about 
obtaining a valid support agreement or to answer any questions about your account.

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, filenames, functions, 
utilities

• URLs, pathnames, filenames, directory names, computer names, links, groups, 
service keys, file systems, notifications

Bold: Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system call, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic: Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier: Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside of 

running text. 

Courier bold: Used for:
• Specific user input (such as commands) 

Courier italic: Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide8
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Your comments Comments and suggestions about our product documentation are always welcome. 

To provide feedback:

1. Go to:

http://Powerlink.EMC.com

2. Click the Feedback link.
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide 9
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Overview
About the NetWorker VSS client
The EMC® NetWorker® VSS (Volume Shadow Copy Service) Client for Microsoft 
Windows works with Microsoft VSS technology to provide snapshot backup and 
recovery services for file systems, and application, and operating system data.

The NetWorker VSS client allows for the creation of point-in-time snapshot data. A 
snapshot can be retained on storage volumes for quick access. One can also perform a 
rollover of a snapshot to a traditional backup medium such as a tape, file type device, 
or advanced file type device. Data can be recovered either from a snapshot or from 
the rolled over backup.

Supported configurations
This section describes the basic configurations in which the NetWorker VSS client is 
supported. A NetWorker VSS client can be set up in a LAN-based or LAN-free 
environment. 

Simple LAN-based configuration
Figure 1 on page 13 shows a simple LAN-based configuration with a storage area 
network. In a LAN-based configuration, the production data is stored on a storage 
area network (SAN) or direct attached storage. The data path to the NetWorker 
storage node devices is over a LAN. The application server that is being protected has 
the NetWorker VSS client installed.

The data moves as follows:

1. The NetWorker server, which must be version 7.3.2 or later, initiates the process 
by contacting the application server where the NetWorker VSS client software is 
installed.

2. The application server with the NetWorker VSS client software creates a snapshot 
of the data on the storage volume.

Note: In the figure, snapshots are represented by S1 through S5.

3. The application server with the NetWorker VSS client software uses a snapshot in 
primary storage to transfer the data over the LAN and into a conventional backup 
medium such as a file type disk, advanced file type disk, or tape.
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide12



Overview
Figure 1 Simple LAN-based configuration

LAN-based configuration with a proxy client
Figure 2 on page 14 shows a LAN-based configuration with a storage area network 
and a proxy client. Both the application server and the proxy client have the 
NetWorker VSS client installed.

A proxy client is a host that acts as a remote data mover when snapshots are rolled 
over to a conventional backup medium. A proxy client frees resources on the 
application server by offloading, from the application server, the work of processing 
and backing up snapshots. When a backup operation uses a proxy client, it is known 
as a serverless backup. 

The data moves as follows:

1. The NetWorker server initiates the process by contacting the application server 
where the NetWorker VSS client software is installed.

2. The application server with the NetWorker VSS client software creates a snapshot 
of the data on the storage volume.

Note: In the figure, snapshots are represented by S1 through S5.

3. The snapshot is made visible to the proxy client.

4. The proxy client uses a snapshot in primary storage to transfer the data over the 
LAN and into a conventional backup medium such as a file type disk, advanced 
file type disk, or tape.

LAN

NetWorker
Storage Node 7.3.x

Primary Storage
e.g., CLARiiON
or Symmetrix

Traditional
Storage

S1 S2

S3
S4

S5

NetWorker Server 7.3.2 or later

Application Server
NetWorker VSS Client

SAN

GEN-000180
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Figure 2 LAN-based configuration with a proxy client

LAN-free configuration
Figure 3 on page 15 shows a LAN-free configuration with a storage area network. The 
NetWorker VSS client is installed on the application server. The proxy client is 
installed on the NetWorker storage node.

You can set up a NetWorker storage node version 7.3.2 or later as a proxy client to 
avoid the network traffic that is generated when a snapshot is rolled over to a 
conventional backup medium. Network traffic is avoided because both the 
conventional backup device and the snapshot are directly attached to the storage 
node.

Note: Install the proxy client software using the NetWorker VSS client software package.

The data moves as follows:

1. The NetWorker server initiates the process by contacting the application server 
where the NetWorker VSS client software is installed.

2. The application server with the NetWorker VSS client software creates a snapshot 
of the data on the storage volume.

Note: In the figure, snapshots are represented by S1 through S5. 

3. The snapshot is made visible to the proxy client.

4. The proxy client, in this case the storage node, uses a snapshot in primary storage 
to transfer the data into a conventional backup medium such as a file type disk, 
advanced file type disk, or tape. 

LAN

NetWorker
Storage Node 7.3.x

Primary Storage
e.g., CLARiiON
or Symmetrix

Traditional
Storage

S1 S2

S3
S4

S5

NetWorker Server 7.3.2 or later

Application Server
NetWorker VSS Client

SAN

GEN-000181

Proxy Client
NetWorker VSS Client
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The NetWorker server and the application server communicate through the LAN. 
However, the data itself is not transferred across the LAN because the 
conventional backup medium is attached directly to the NetWorker storage node.

Figure 3 LAN-free configuration
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Understanding the VSS snapshot creation process
Microsoft Volume Shadow Copy Service (VSS) acts as a coordinator among the 
following three components that create, modify, back up, and recover data:

◆ Requestors
Requestors include the NetWorker backup application.

◆ Writers
Including writers for operating system data, application data such as Microsoft 
Exchange or SQL Server data, and file system volumes such as a D:\ data drive.

◆ Providers
Providers include the Microsoft VSS software provider or hardware-based 
providers such as the EMC VSS Provider.

In VSS, NetWorker software is a requestor—an application that performs the backup 
and recovery of applications or services. When a requestor performs a backup or 
recovery, the following occurs:

1. The requestor asks for information from VSS.

2. VSS reviews the request for validity.

3. VSS sends writer data from multiple application and system writers to the 
requestor.

4. The requester tells VSS which writers and volumes to include in the snapshot.

Each application and service that supports VSS has its own writer, which 
understands how the application or service works. After the writer signals that it has 
prepared the data the following occurs:

◆ The VSS software:

• Directs the writer to freeze input/output (I/O) to the selected volumes.

• Queues transactions for later processing. 

• Calls a provider to capture the requested data. 

◆ The provider:

• Captures the prepared data.

• Creates a snapshot that exists side-by-side with the live volume. 

After the snapshot is created:

• The provider signals VSS, this signal tells the writer to resume activity. 

• I/O is released to the selected volumes and any queued writes that arrived 
during the provider's work are processed.

Figure 4 on page 17 illustrates the VSS backup process.
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide16
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Figure 4 VSS backup process

About writers
Writers provide information about what data to back up, and specific methods for 
handling components and applications during backup and recovery. They also 
identify the type of application or service that is being backed up. 

If a service or application is present on a system but is not active, information from its 
writer will not be available. Consequently, a writer can appear or disappear from 
backup to backup. 

Writer Writer

Writer Writer

Writer

Requestor

4. Requestor
    asks VSS
    to create
    snapshot.

1. NetWorker software (the requestor)
    asks VSS to enumerate writers and
    gether their metadata.

2. Writers provide an XML description
    of backup components and define
    the recover method.

5. VSS tells the writers to
    freeze activity.

7. VSS tells the writers to
    resume activity.

3. VSS asks which providers can
    support a snapshot for each of
    the required volumes.

6. VSS tells the providers to
    create the snapshot of the
    current state on disk.

Disk 1 Disk 2 Disk 3

Microsoft VSS
Software Provider

EMC VSS Provider
(CLARiiON or Symmetrix)

Disk 3
GEN-000188
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Supported writers
Table 1 lists the writers that are supported for the NetWorker VSS client:

About providers
A provider is used to capture snapshots. Two types of providers are available: either 
the Microsoft VSS software provider or a hardware-based provider such as the EMC 
VSS Provider. The Microsoft VSS software provider is a host-based provider that 
works with any type of storage hardware. The EMC VSS Provider works with a 
CLARiiON® or Symmetrix® disk array. Some features of the NetWorker VSS client, 
such as serverless backup and rollback recovery, are only available with hardware 
providers such as the EMC VSS Provider. 

Providers and backup performance
The Microsoft VSS software provider uses a copy-on-write snapshot technology. 
Some hardware providers such as the EMC VSS Provider, support split-mirror 
snapshot technology as well as copy-on-write technology. Although copy-on-write 
technology requires less hardware resources, split-mirror technology provides better 
performance.

Large or fast-changing databases should not be saved with copy-on-write snapshot 
technology. The input/output requirements of these databases can cause the 
copy-on-write cache to overflow and invalidate the snapshot. Additionally, 
copy-on-write technology cannot match the performance of split-mirror technology. 
For large or fast-changing database, use the EMC VSS Provider in conjunction with 

Table 1 Currently supported writers

Writer Type Includes writers for:

Volumes A file system path such as D:\data

Applications Microsoft ADAM (Active Directory Application Mode)
Microsoft Exchange 2003
Microsoft SQL Server 2000 service pack 4
Microsoft SQL Server 2005
Microsoft FRS 2 (Distributed File Replication Server)

Windows System Components BITS (Background Intelligent Transfer Service)
COM+ REGDB (Registration Database)
Certificate Authority
Cluster service
DHCP (Dynamic Host Configuration Protocol) Jet
Event log
FRS (File Replication Server)
IIS (Internet Information Services) Metabase
MSDE (Microsoft SQL Server Desktop Engine for SQL 2000 
embedded databases)
NTDS (Active Directory Schema)
Registry
RSM (Removable Storage Manager)
Remote Storage Manager
System Components
TermServLicensing
WINS (Windows Internet Name Service)
WMI (Windows Management Instrumentation)
FSRM (File Storage Resource Manager)
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide18
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EMC hardware to provide a split-mirror storage solution such as a CLARiiON clone 
or a Symmetrix BCV. 

NetWorker VSS client snapshot backups
Backups are configured as scheduled snapshot backups on a NetWorker server 
release 7.3.2 or later.

Note: Ad hoc (manual) backups, from either the command line or from the NetWorker VSS 
client, are not supported. However, one can manually start a scheduled backup at any time.

The NetWorker VSS client supports three types of snapshot backups: 

◆ “Nonpersistent rollover backup” on page 19

◆ “Instant backup with or without rollover” on page 19

◆ “Serverless backup” on page 19

Snapshot backups are specified through a snapshot policy and various settings for 
the Client resource. Snapshot policies and Client resources are set up on the 
NetWorker server. For more information, see Chapter 2, ”Configuring a Scheduled 
Backup.”

Nonpersistent rollover backup
A nonpersistent snapshot backup (also referred to as a live backup) creates a 
point-in-time snapshot of the data and then performs a rollover to a conventional 
backup medium such as tape, file, or advanced file type device. The original snapshot 
is automatically deleted from the NetWorker VSS client.

Instant backup with or without rollover
An instant backup creates and retains a snapshot on a mounted storage disk volume. 
Depending on how backups are configured, a snapshot that is created during an 
instant backup may be configured to roll over to a conventional backup. While the 
snapshot resides on a mounted storage disk volume, it is referred to as a persistent 
snapshot.

Retaining persistent snapshots on a mounted storage disk volume enables one to 
perform an instant recovery. The number of persistent snapshots that can be retained 
on a volume depends on the amount of resources available.  Other factors that 
constrain the number of persistent snapshots include:

◆ The snapshot technology that is used, either copy-on-write or split-mirror.

◆ The input/output patterns of the drive.

◆ The processing involved in running a snapshot backup group.

Serverless backup
A proxy client is used in conjunction with instant snapshot backups to provide 
serverless backups. Serverless backups free the application server from much of the 
processing involved in a nonpersistent or instant snapshot backup. In a serverless 
backup, a snapshot is created on the application server and then immediately moved 
to the proxy client for further processing.
NetWorker VSS client snapshot backups 19
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Serverless backups are particularly useful when there is additional processing 
involved in a snapshot backup. For example, to help determine whether a snapshot of 
a Microsoft Exchange database is consistent, the Exchange utility, eseutil, should be 
run against the snapshot. Running eseutil can be disk intensive. Offloading the work 
from the Exchange server to a proxy client frees resources on the Exchange server.

A serverless backup can be rolled over to a conventional backup and the backup can 
remain on the mounted storage disk volume as a persistent snapshot.

Note: Serverless backup is available only with VSS hardware providers and is subject to the 
capabilities of the vendor’s hardware. The EMC VSS Provider for CLARiiON and Symmetrix 
provides the capability to perform serverless backup operations for these storage platforms.

NetWorker VSS client recoveries
There are three types of recoveries: 

◆ “Conventional recovery” on page 20

◆ “Instant recovery” on page 20

◆ “Rollback recovery” on page 21

By default, recoveries are performed from a conventional backup. If a conventional 
backup is not available for the selected browse time, an instant recovery is performed. 
The default recovery method can be specified in the NetWorker recovery options 
dialog box. For more information, see “NetWorker recovery options” on page 51.

Conventional recovery
A conventional recovery consists of recovering data from a snapshot that has been 
rolled over to tape. Conventional recoveries support the same level of item selection 
as do instant recoveries.

Instant recovery
Instant recoveries are performed on persistent snapshots. An instant recovery can 
take less time to complete than a conventional recovery because the snapshot is 
available on a mounted disk storage volume rather than on a conventional backup 
medium.

Instant recoveries support the selection of individual files in a file system snapshot. 
Additionally, instant recoveries support the selection of individual components at 
whatever level of granularity is supported by the system or application writer. 

If the persistent snapshot is created using a proxy client, the snapshot file system on 
the proxy client is read to restore the files.  In this way, performance is improved even 
further because the job of processig the snapshot for recovery is offloaded from the 
NetWorker VSS client production host to the proxy client.
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide20
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Notes: 
The procedure to perform an instant recovery of file system data differs if only a persistent 
snapshot is available. For more information, see Chapter 3, ”Recovering Data.”

When performing an instant recovery, the snapshot may become invalidated.  This can occur if 
the snapshot is based on copy-on-write technology. If a large amount of data is recovered to the 
original volume, the cache may overflow. This is true for the Microsoft VSS software provider 
and for hardware providers that use copy-on-write technology, such as CLARiiON snapshots 
and Symmetrix virtual devices (VDEVs).

Rollback recovery
A rollback recovery is the process of returning data volumes to an earlier 
point-in-time. The entire contents of a persistent snapshot is recovered during a 
rollback recovery. One cannot select individual components in a rollback recovery 
operation. A rollback recovery is the fastest way to recover the contents of a persistent 
snapshot.

A rollback recovery is known as a "destructive" recovery because all changes that 
were made to the file systems after the selected snapshot was taken are overwritten. 
For example, suppose that a snapshot of a database is taken every hour. At 5:30 P.M., 
it is determined that the database is corrupt and that the last known consistent 
database snapshot was taken at 5:00 P.M. When the database host is rolled back to the 
5:00 P.M. snapshot, all database transactions between the time of the 5:00 P.M. and 
5:30 are overwritten.

Notes: 
The snapshot to be rolled back must reside on a CLARiiON or Symmetrix storage 
system that is supported with the EMC VSS Provider.

The NetWorker VSS client to which the snapshot is to be rolled back must be 
supported with a proxy client.

For more information about rollback recoveries, see “Roll back a snapshot” on 
page 80.
NetWorker VSS client recoveries 21
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About the NetWorker VSS client interface
The NetWorker VSS client interface has three views: 

◆ “Recover view” on page 22

◆ “Snapshot Management view” on page 24

◆ “Monitor view” on page 25

Recover view
With the exception of rollback recovery, all recoveries are performed from the 
Recover view. Rollback recoveries use the Snapshot Management view. Figure 5 on 
page 22 shows the Recover view.

Figure 5 NetWorker VSS client main window

Navigation tree

View-Specific toolbarAvailable views

Client selection 
(clustered client only)

Main toolbar

Summary of selected items
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The summary of selected items can also display an exclusion representation, which 
shows only those items that are not selected for recovery. This view can be helpful 
when many items are selected for recovery. Figure 6 shows an exclusion 
reresentation.

Figure 6 Exclusion representation of recover items

To view an exclusion representation, right-click in the Summary pane at the bottom of 
the window and select Exclusion Representation.

Items in red are 
excluded from 
recovery
About the NetWorker VSS client interface 23
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Snapshot Management view
Various operations on snapshots are performed from the Snapshot Management view 
shown in Figure 7 on page 24.

Figure 7 Snapshot Management view

The following operations can be performed on snapshots:

◆ Rollover snapshot

◆ Rollback snapshot

◆ Delete snapshot

In most cases, snapshot rollover and delete operations are performed automatically 
based on snapshot policies, which are set up on the NetWorker server. However, if 
you need to manually delete or rollover a snapshot, you can do so in the Snapshot 
Management view. For more information about snapshot policies, see Chapter 2, 
”Configuring a Scheduled Backup.” For more information about performing manual 
snapshot operations from the Snapshot Management view, see Chapter 6, ”Snapshot 
Management.”
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide24
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Monitor view
Recovery and snapshot management operations can be monitored in the Monitor 
view shown in Figure 8 on page 25.

Figure 8 Monitor view

Most messages displayed in the Monitor view are also written to log files. For more 
information about log files, see Chapter 8, ”Troubleshooting.” You can also copy and 
paste text from the Monitor view to another application.

Using the NetWorker VSS client graphical user interface
This section describes how to perform the following basic tasks in the NetWorker VSS 
client interface.

Opening the software and connecting to a NetWorker server
To recover data, you must connect to the NetWorker server on which the backup was 
configured. 

Note: Upon opening the NetWorker VSS client for the first time, the Change NetWorker Server 
dialog box displays automatically. In this case, begin this procedure at step 3.

To connect to a NetWorker server: 

1. From the Start menu, open the NetWorker VSS client software.

2. From the Main toolbar, click the NetWorker Server icon. 

The Change NetWorker Server dialog box appears.

3. Click Update Server List to browse for NetWorker 7.3.2 or later servers. The 
discovery process may take a few minutes.
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4. When the list is updated, select a server. The selection appears in the Server field.

You can also type a name in the Server field.

5. Click OK.

Note: You can also select Configure Options from the Options menu to connect to a 
NetWorker server.

Selecting an item for recovery
To select items for recovery:

◆ Click the checkbox beside a node in the Navigation Tree. To clear an item, click 
the checkbox again.

A checkmark indicates that the node is selected. By default, all items contained in 
the node, such as folders and files, will also be selected for recovery.

To clear an item contained in a selected node:

◆ Expand the node and click the checkbox beside the item to clear it. The 
checkmark disappears.

Figure 9 on page 26 depicts one selected item and several partially selected nodes in 
the Navigation Tree.

Figure 9 Selected and partially selected items

Searching for an item
To search for a recovery item:

1. Select the Search tab above the Navigation Tree.

2. In the Path field, type a directory path.

3. Optionally, in the Name field, type the name of the search item.

Checkmark indicates that the item is selected.
Solid box indicates that at 
least one item below this 

node is not selected.
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You can refine your search as follows:

• Literal match (case-insensitive)
Type abc to return abc or ABc but not abcd or ABCD.

• Literal match (case-sensitive)
Type "abc" to return abc but not ABc or abcd.

• Name contains (case-insensitive)
Type %abc% to return abc, abcd, ABCD, or xyzABCde

• Name starts with (case insensitive) 
Type abc% to return abcd or ABCde but not xyzABCde

• Name ends with (case insensitive)
Type %abc to return xyzAbc but not ABCde

4. Click Search.

The Details pane displays the results of the search.

Specifying a recovery browse time
To browse for items that were backed up on or before a particular time: 

1. From the application toolbar, click the Browse calendar icon. 

2. Click the arrows to select the date and time; click OK.

The Navigation Tree displays backup items from the specified date and prior.

Selecting a backup version for recovery

Note: This topic applies to system recovery or Active Directory recovery operations only. For 
information about rollback snapshot recoveries, see “Snapshot Management” on page 79.

To view the versions of an item that were backed up prior to the current browse time: 

1. In the Navigation Tree, select a recover item. For more information, see “Selecting 
an item for recovery” on page 26. 

2. Right-click the selected item and select Versions from the pop-up menu.

3. Select the backup version to recover.

4. Select Use selected item backup time as new browse time to change the browse 
time to the same date as the selected backup version.

5. Click OK.

The recover items displayed in the Navigation Tree are from the selected browse 
time.
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Viewing the volumes required for a recovery
There are no NetWorker volumes associated with a snapshot backup until the 
snapshot has been rolled over to a NetWorker server. If you select to view the 
required volumes for a System Component or application data snapshot that has not 
been rolled over, no volumes will be displayed.

To view the volumes that are required for a recovery operation: 

1. In the Navigation Tree, select a recover item. For more information, see “Selecting 
an item for recovery” on page 26. 

2. Right-click the selected item and select Required Volumes from the pop-up 
menu.

The Required NetWorker Volumes dialog box appears with a list of the volumes 
that must be mounted. 

• If a volume is already mounted, the device name is shown after the volume 
name. 

• If a required volume is not mounted, the administrator is prompted to mount 
it after the recovery operation is started.

3. Click OK.
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Backup configuration roadmap
Use the following roadmap to plan your backups.

To back up volume data such as a drive letter or to back up Windows system 
components such as the registration database:

◆ Complete tasks 1 through 7.

To back up application data such as SQL or Exchange:

◆ Evaluate the information in
“Best practices and considerations for backing up application data” on page 30.

◆ Complete tasks 1 through 7.

To back up a NetWorker VSS client that is part of a cluster:

◆ Evaluate the information in
“Backing up a clustered NetWorker VSS client” on page 46

◆ Complete tasks 1 through 7.

To back up an Active Directory server:

◆ Complete Chapter 4, ”Active Directory and ADAM Backups.”

Best practices and considerations for backing up application data
Table 2 lists the considerations to be aware of when specifying values in the Save Set 
attribute for a particular Client resource.

Table 2 Application backup best practices and considerations (1 of 2)

Consideration Description

Different policies for 
application server data

For application servers such as SQL or Exchange servers, consider 
backing up the server application data under a different schedule than the 
host operating system data and volumes. Typically, application data is 
backed up several times a day while operating system data and volumes 
are backed up less frequently. To accomplish this, create a separate 
backup group, snapshot policy, and Client resource for:
• server application data
• volumes and operating system data
Assign the appropriate snapshot policy and Client resource to each 
backup group.

Installation path for 
application server 
program

Do not install application server program files on the same volume as the 
application’s database files and log files.

Copy-On-Write versus 
Mirroring

Large or fast-changing databases should not be saved with 
Copy-on-Write snapshot technology. Instead, use a split-mirror snapshot 
technology such as a CLARiiON clone or a Symmetrix BCV. 
Although Copy-on-Write technology requires less hardware resources, 
split-mirror technology can better handle the requirements of large or 
fast-changing databases. 
Split-mirror technology is only supported with the EMC VSS Provider.

NetWorker modules and 
the NetWorker VSS client

If you attempt to use both the NetWorker VSS client and a NetWorker 
module to backup application data, the module backups will be promoted 
to Full backups. For more information, see “NetWorker VSS client issues” 
on page 92.
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide30



Configuring a Scheduled Backup
Task 1: Configure a backup pool for snapshot operations
Snapshots create metadata that is used in the management of snapshot operations 
such as an instant recovery operation. Create a snapshot pool to store the save sets 
that contain snapshot metadata. 

Configuration a backup pool is a four-part process:

1. “Configuring a device” on page 32

2. “Configuring a label template” on page 32

3. “Configuring a backup pool” on page 33

4. “Labeling the device” on page 33

Note: All of the tasks in this section must be performed on a NetWorker server release 7.3.2 or 
later. Access the NetWorker server from the Administration window of the NetWorker 
Management Console. 

For more information about performing the steps in this section, refer to the 
NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide or later.

Microsoft Exchange data The Exchange server must have Exchange Server Service Pack 1 (SP1) 
or later installed.

After upgrading to the NetWorker VSS client, you cannot recover 
Exchange backups that were performed with a previous version of the 
NetWorker client. To ensure that all Exchange data can be recovered to 
the point-in-time of the upgrade, perform a full backup of Exchange data 
immediately after upgrading to the NetWorker VSS client.

Save sets and backup groups that include the Exchange writer cannot 
include other application writers or the SYSTEM COMPONENTS writer. 
The Exchange writer can however, be included in the same save set with 
volume components such as D:\.

Database files and log files must reside on separate volumes for the 
Exchange server. If they are on the same volume, backup will fail.

If Exchange has been installed after the NetWorker VSS client software or 
if the Exchange username, password, or domain has changed, run the 
nwexinfo.exe utility to update the NetWorker VSS client. 
For more information, refer to the EMC NetWorker VSS Client for 
Windows Server 2003 First Edition Installation Guide.

When installing the NetWorker VSS client or when running the 
nwexinfo.exe utility, the correct Exchange username and password must 
be specified. Otherwise all backups for the client resource will fail. Even 
backups that do not include Exchange data will fail if the username or 
password was specified incorrectly. 

Microsoft SQL data If SQL 2005 backups were performed when the SQL Server VSS Writer 
service was disabled, and you subsequently enable the writer, perform a 
complete backup of SQL 2005 data. Performing a complete backup 
enables you to recover all SQL 2005 data from the same application 
folder, which is named SQLServerWriter.

Table 2 Application backup best practices and considerations (2 of 2)

Consideration Description
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Configuring a device
Configure a media device for snapshot metadata. Configure a tape, file, or advanced 
file type device. For best performance, configure a file or advanced file type device so 
that a snapshot can be recovered without the potential delay associated with 
retrieving a tape.

To configure a device:

1. In the Administration window of the NetWorker Management Console, click 
Devices.

2. In the expanded left pane, select Devices.

3. From the File menu, select New.

4. In the Name attribute, replace the default name with the path and name of the 
device.

• If the device is configured on the NetWorker server’s storage node, the name 
is the simple device path, such as c:\tmp\d0 for a file type device. 
A tape device would have a format similar to \\.\Tape0.

• If the device is configured on a remote storage node, the name must indicate 
that the storage node is remote, by including rd= and the name of the remote 
storage node in the device path. For example, if the remote storage node is 
neptune, then the device path might be rd=neptune:c:\tmp\d0.

5. In the Comment field, specify a comment for the device.

6. From the Media Type attribute, select the appropriate media type.

7. Click the Auto Media Management attribute so that a checkmark appears beside 
it.

8. Click the Configuration tab.

9. In the Target Sessions attribute, type or select a value. Set this attribute to a large 
value to speed up the backup.

10. Click OK.

Configuring a label template
Labels identify the kind of data that is stored on the volumes in a backup pool. Label 
templates define a naming convention for labels. Create a label template for volumes 
that are used to contain snapshot metadata.

To configure a label template:

1. In the Administration window of the NetWorker Management Console, click 
Media. 

2. In the expanded left pane, select Label Templates.

3. From the File menu, select New.

4. In the Name attribute, type a name that identifies the series of labels as belonging 
to volumes for snapshot metadata.

5. In the Comment attribute, specify a comment for the label.
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6. In the Fields attribute, specify a text name such as Snapshot_Metadata and on a 
separate line, specify a numeric range such as 001-999 or a text range such as 
aa-zz. 

These attributes are used to incrementally identify each label.

7. Click OK.

Configuring a backup pool
To configure a backup pool to store snapshot metadata:

1. In the Administration window of the NetWorker Management Console, click 
Media.

2. In the expanded left pane, select Media Pools.

3. From the File menu, select New.

4. For the Name attribute, type a name that matches the label template.

5. In the Comment attribute, specify a comment for the pool.

6. Select the Enabled attribute.

7. For the Pool Type attribute, select the Backup Pool type.

8. For the Label Template attribute, select the matching label template.

9. Do not select a group in the Groups attribute.

Do not associate the pool with a particular group. This pool may be associated 
with several backup groups, so a single group should not be specified here.

10. Click the Selection Criteria tab.

11. For the Clients attribute, specify a NetWorker VSS client. A value must be entered 
for this attribute because no group was specified.

12. In the Devices attribute, select each device that can accept snapshot rollovers for 
this pool.

13. Click OK.

Labeling the device
Before a device can be used for backup, it must be labeled.

To label a device:

1. In the Administration window of the NetWorker Management Console, click 
Devices.

2. In the right pane, right-click on the name of the device and select Label.

3. In the Pool attribute, select the backup pool that was created.

4. Select the Mount after Labelling attribute.

5. Click OK.
Task 1: Configure a backup pool for snapshot operations 33



Configuring a Scheduled Backup
Task 2: Configure snapshot policies
A snapshot policy determines the following:

◆ When and how often are snapshots created?

◆ How many snapshots, if any, are retained as persistent snapshots?

◆ Which snapshots, if any, are rolled over to conventional storage?

◆ When do snapshot expire and become eligible for deletion?

Note: Snapshots can also be manually rolled over or deleted. For more information, see 
Chapter 6, ”Snapshot Management.”

You can specify a preconfigured policy or create a custom snapshot policy. The 
following preconfigured snapshot policies exist:

◆ Serverless

A single snapshot is taken per day. The data is then rolled over to conventional 
storage and the snapshot is deleted.

◆ Daily

Eight snapshots are taken per day. The data in the first snapshot is rolled over to 
conventional storage. Each snapshot has an expiration policy of 24 hours.

CAUTION

Ensure that your snapshot policies include at least one rollover to conventional 
backup. Disaster recovery can only be performed from a conventional backup.

Creating a snapshot policy
To create a custom snapshot policy:

1. In the Administration window of the NetWorker Management Console, click 
Configuration.

2. In the expanded left pane, select Snapshot Policies.

3. From the File menu, select New.

4. In the Name attribute, type a name for the snapshot policy.

5. In the Comment attribute, type a comment for the snapshot policy.

6. In the Number of Snapshots attribute, enter the number of snapshots to be 
created per day. 

The Number of Snapshots attribute works in conjunction with the Group 
resource Interval and Start Time attributes. The value for the Start Time and 
Interval attributes must allow the specified number of snapshots to be created in 
a 24-hour period. For example, if you want to take four snapshots per day and the 
first snapshot must occur at 4:00 A.M. (Start Time attribute), then the Interval 
attribute must be set to 5 hours or less.

Number of Snapshots < (24:00 - Start Time) / Interval

For more information, see “Task 4: Configure a backup group” on page 37.
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7. In the Retain Snapshots attribute, enter the maximum number of snapshots that 
can be retained for a specified period of time before being expired. The period of 
time is specified in the Snapshot Expiration Policy attribute.

Note: Use a minimum Retain Snapshot value of two.  This will insure that the most recent 
snapshot is retained while the new snapshot is created.  A Retain Snapshot value of one 
will delete  the only snapshot copy while creating the new snapshot.

8. In the Snapshots Expiration Policy attribute, select a preconfigured expiration 
policy to determine how long snapshots can be retained before being deleted.

9. In the Backup Snapshots attribute, specify which snapshots will be rolled over to 
a conventional storage medium.

Valid values are All, None, First, Last, Every n.

CAUTION

Implement a regular snapshot rollover policy to protect data against a disaster 
such as a hardware failure.

If the Backup Snapshot attribute is set to None, you can still roll over the snapshot 
manually. For more information, see Chapter 6, ”Snapshot Management.”

10. Click OK.

Snapshot policy examples
Table 3 depicts settings for a conventional backup. Four snapshots per day are taken. 
All snapshots are rolled over to a conventional storage medium. Each snapshot is 
deleted after it is rolled over.

Table 4 depicts settings for an instant backup. Four snapshots per day are taken. Up 
to 28 snapshots are retained for a maximum period of one week. No snapshots are 
rolled over.

Table 3 Conventional snapshot policy

Name Conventional backup

Comment Rollover and then delete.

Number of Snapshots 4

Retain Snapshots 0

Snapshot Expiration Policy Day

Backup Snapshots All

Table 4 Instant snapshot policy (1 of 2)

Name Instant backup

Comment Persistent snapshots with no rollovers.

Number of Snapshots 4
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Table 5 depicts settings for an instant backup with rollover to a conventional 
medium. Four snapshots per day are taken. Up to 28 snapshots are retained for a 
maximum period of one week. Every first and third snapshots are rolled over.

Task 3: Configure a backup schedule
Backup schedules determine the days on which full or incremental backups are run. 
Full backups include all of the data specified in a NetWorker VSS client resource save 
set, while incremental backups include only the data that has changed since the last 
backup.

Table 6 contains the considerations to be aware of when configuring a backup 
schedule for a NetWorker VSS client. The procedure for creating backup schedules 
for a NetWorker VSS client is the same as for creating a backup schedule for a regular 
NetWorker client. 

Note: The information in Table 6 applies only to rollover backup operations. Snapshots are 
always taken at Full level.

Retain Snapshots 28

Snapshot Expiration Policy Week

Backup Snapshots None

Table 4 Instant snapshot policy (2 of 2)

Table 5 Instant snapshot with rollover policy

Name Instant and conventional backup

Comment Persistent snapshots with rollover to tape.

Number of Snapshots 4

Retain Snapshots 28

Snapshot Expiration Policy Week

Backup Snapshots Every 1 (press Enter)
Every 3

Table 6 Considerations for NetWorker VSS client backup schedules

Backup levels Consideration

Full level These backups are supported for all types of data.

Incremental 
backups

These are supported only for backup of volume directories and 
paths such as E:\ or E:\business_files\.

Level 1 to 9 
backups

These are supported only for backup of volume directories or paths 
such as E:\ or E:\business_files\.
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Task 4: Configure a backup group
Backup groups enable you to balance backup loads to reduce the impact on your 
storage and network resources. Use a backup group to assign the following attributes 
to a set of Client resources:

◆ Snapshot policy

◆ Backup start times

◆ Schedules

◆ Backup pools

Note: A client resource or backup group cannot specify volumes that use both CLARiiON and 
Symmetrix storage systems. For hosts that have both CLARiiON and Symmetrix volumes, 
create separate backup groups and client resources. Each backup group and its client resources 
can specify volumes from only one type of storage system.

To configure a backup group:

1. In the Administration window of the NetWorker Management Console, click 
Configuration.

2. In the expanded left pane, select Groups.

3. From the File menu, select New.

4. In the Name attribute, type a name for the backup group.

5. In the Comment attribute, type a description.

6. For the Start Time attribute, enter the time when the first snapshot is to be 
created.

7. For the Autostart attribute, select Enabled.

8. Click the Snapshot attribute so that a checkmark appears beside it.

9. For the Snapshot Policy attribute, select a snapshot policy. For more information 
about snapshot policies, see “Task 2: Configure snapshot policies” on page 34.

10. For the Snapshot Pool attribute, select a pool that was created for the snapshot. 
For more information about pools, see “Task 1: Configure a backup pool for 
snapshot operations” on page 31.

11. Click the Advanced tab.

12. For the Interval attribute, specify how often a snapshot will be created. 

The Interval attribute works in conjunction with the backup group Start Time 
attribute and the snapshot policy Number of Snapshots attribute. For example, if 
you want to take four snapshots per day (Number of Snapshots attribute) and 
the first snapshot must occur at 4:00 A.M. (Start Time attribute), then the Interval 
attribute must be set to 5 hours or less.

Number of Snapshots < (24:00 - Start Time) / Interval

13. Ensure that Restart Window attribute value is less than or equal to the Interval 
attribute value.

14. Set the Client Retries attribute to 0 (zero).

15. Click OK to create the backup group.
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Task 5: Configure a Client resource
A Client resource specifies what to include in a snapshot of a NetWorker VSS client. 
Client resources are associated with other backup resources such as groups and 
snapshot policies.

You can create multiple Client resources for the same NetWorker VSS client host. In 
this way, you can apply different backup attributes to different types of information 
on the same host. For example, if the NetWorker VSS client host is an Exchange 
server, you can create one Client resource to backup the Exchange databases and 
create another Client resource to backup Windows system component data. This way, 
you can backup Exchange databases many times a day and back up Windows system 
component data only once a day.

To create a Client resource:

1. In the Administration window of the NetWorker Management Console, click 
Configuration.

2. In the expanded left pane, select Clients.

3. From the File menu, select New.

4. In the Name attribute, type the hostname of the NetWorker client computer.

5. In the Comment attribute, type a description. If you are creating multiple Client 
resources for the same NetWorker client host computer, use this attribute to 
differentiate the purpose of each resource.

6. From the Browse Policy attribute, select a browse policy from the list. The browse 
policy determines how long rolled-over data is available for quick access.

7. From the Retention Policy attribute, select a retention policy from the list. The 
retention policy determines how long rolled-over data is available though not 
necessarily quickly.

8. Select the Scheduled Backups attribute.

9. In the Save Set attribute, specify the components to be backed up. Place multiple 
entries on separate lines.

To specify all volume data and all available Windows system components:

• Type All

Application data such as Exchange data is not included in the save set All.

To back up specific volumes:

• Type the volume name. For example, to specify the volume E and all of its 
subfolders and files, type:
E:\

• To specify only a particular folder or file such as a folder named large_net 
and all files and folders under large_net, type:
E:\client_data\large_net\

Entries are not case-sensitive.

• To specify volume mount point data, place the name of the mount point on a 
separate line. For example, if you have a mount point named CAD_Drawings 
on volume E:\ and you want to back up all of the data on E:\ including the 
data under the mount point, type:
E:\ (press Enter)
E:\CAD_Drawings
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The save set All will include mount point data only if no other path to the 
remote data is found during backup.

To specify all available Windows system components such as the registration 
database and Windows event log, type the save set All or type following:

• SYSTEM COMPONENTS:\
Ensure that the backslash (\) character is entered with the save set name 
SYSTEM COMPONENTS:\. Otherwise, backup fails and no concise error 
message is provided.

To specify application data such as Exchange data, type:

• APPLICATIONS:\Microsoft Exchange Writer\

• For more information about specifying save set syntax for applications, see 
“Specifying save sets for application data” on page 40.

If you are backing up data for a Microsoft Exchange application, ensure that all 
databases in a specified Storage Group are mounted. If at least one database in a 
selected Storage Group is not mounted, the entire backup of the Storage Group will fail.

If you are backing up data for a Microsoft SQL application, ensure that all SQL 
databases are mounted.  Unmounted databases are not backed up.

CAUTION

To protect against a disaster, ensure that all volumes and Windows system 
components are backed up. Also ensure that the associated snapshot policy 
includes at least one rollover to a conventional backup. Disaster recovery can only 
be performed from a conventional backup.

10. For the Group attribute, select the backup group to which this client resource will 
be added.

If client resources for the same NetWorker VSS client host are added to different 
backup groups, ensure that the Start Time attribute for each backup group is 
spaced far enough apart so that the backups for the host’s client resources do not 
overlap.

11. For the Schedule attribute, select a backup schedule.

12. Select the Apps & Modules tab.

13. In the Backup command attribute, type the backup command.

• For all types of backup data except for Active Directory conventional backups, 
type:
nsrsnap_vss_save.exe

For information about Active Directory backups, see “Performing a conventional 
AD or ADAM backup” on page 70.

14. In the Application information attribute, type the following variable and value:

NSR_SNAP_TYPE=vss

Type any additional variables and their values on a separate line. 

Additional variables include specifications for a data mover (proxy client) and for 
Exchange set up attributes. For information about additional variables and their 
values, see “Application information variable settings” on page 43.
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15. If a proxy client is being set up for the NetWorker VSS client, type the hostname of 
the proxy client in the Remote Access attribute.

If the NetWorker VSS client is part of a cluster, type the names of the physical 
nodes of the cluster in the Remote Access attribute. 

16. Click OK.

Specifying save sets for application data
Table 7 lists the save set syntax to specify for supported types of application data. 
Specify application data save sets in the Save Set attribute of a Client resource. 

To find the exact name of a particular Exchange storage group or SQL Server instance 
and database combination, see “Displaying valid application data save sets” on 
page 41. 

Table 7 Save set syntax (1 of 2)

Type of data to back up Save set syntax

Exchange application data

All Exchange storage groups. APPLICATIONS:\Microsoft Exchange Writer\

Back up just the Exchange storage group 
named, group_name.

Applications:\Microsoft Exchange
Writer\group_name

Some special characters in an Exchange storage group name 
must be replaced with URL encoded values. For more 
information, see “URL encoding for SQL and Exchange save 
sets” on page 42.

SQL application data

All SQL 2000 embedded databases SYSTEM COMPONENTS:\

All SQL 2000 named instances and 
standalone databases.

APPLICATIONS:\MSDEWriter-SQL2000\

Only the SQL 2000 host instance and 
database name combination. 

APPLICATIONS:\MSDEWriter-SQL2000\host\
instance\master

For example, to backup the database named accounts07 on the 
SQL Server named instance MT11\AP, type the following:
APPLICATIONS:\MSDEWriter-SQL2000\
MT11%5CAP\accounts07

Some special characters in a SQL Server named instance or 
database name must be replaced with URL encoded values. For 
more information, see “URL encoding for SQL and Exchange 
save sets” on page 42.

All SQL Server 2005 named instances and 
databases including express and standalone 
databases.

If the SQL Server VSS Writer service is enabled (it is disabled by 
default), type the following:
APPLICATIONS:\SqlServerWriter\

If the SQL Server VSS Writer service is disabled, SQL 2005 
named instances and databases including express and 
standalone databases, can be backed up with the following 
syntax:
APPLICATIONS:\MSDEWriter-SQL2000\
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Displaying valid application data save sets
To display a list of the application data save sets that are available for back up:

1. Open a command-prompt on the application server.

2. From the command-prompt, type the following command to list the valid 
application data save set names.

If the application server is not on a virtual host, type:

nsrsnap_vss_save -?

If the application server is on a virtual host, type:

nsrsnap_vss_save -? -c virtual_server_name

Note: If the application server is on a virtual host, run this command from the physical 
node that is currently hosting the application server.

3. Press Enter.

The application data save sets that are available for backup are listed in a format 
similar to the following:

"APPLICATIONS:\SqlServerWriter"
"APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON"
"APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON\master"
"APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON\model"
"APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON\msdb"
"APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON\NADATA"

Only the SQL 2005 host instance and 
database name combination. 

APPLICATIONS:\SqlServerWriter\host\
instance\master

For example, to backup the database named trans07 on the 
SQL Server named instance MT11\BU, type the following:
APPLICATIONS:\SqlServerWriter\MT11%5CBU\
trans07

Some special characters in a SQL Server named instance or 
database name must be replaced with their URL encoded 
values. For more information, see “URL encoding for SQL and 
Exchange save sets” on page 42.

DFS data Applications:\DFS Replication service 
writer\

Also back up the SYSTEM COMPONENTS:\ save set on the 
namespace server (usually the domain controller) that is 
associated with the DFS configuration.

Note: To backup DFS objects, the searchFlags attribute on the 
Active Directory server must be set to 8. For more information, 
see “Set searchFlags attribute on shared folder and DFS 
objects” on page 70.

ADAM data Applications:\ADAM (instance_name) Writer

For example, the ADAM instance named AddressBook would 
be entered as:
Applications:\ADAM (AddressBook) Writer

Active Directory For information about backing up Active Directory services, see 
Chapter 4, ”Active Directory and ADAM Backups.”

Table 7 Save set syntax (2 of 2)

Type of data to back up Save set syntax
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Each line of output corresponds to a save set entry that you can add to the Save 
Set attribute of a Client resource. Each entry that you add to the Save Set attribute 
must be typed on a separate line.

URL encoding for SQL and Exchange save sets
When specifying save set names in the Save Set attribute of the client resource, there 
are cases where special characters, such as the backslash (\), must be specified by 
their URL encoded values. URL encoded values are used to represent special 
characters in the following cases:

◆ SQL Server named instances

◆ SQL Server database names

◆ Exchange storage groups

Consider the following example of a SQL Server named instance. The name of a SQL 
Server named instance consists of two parts: the name of the host and a unique name. 
These two parts are always separated with a backslash (\) character. When specifying 
a SQL Server named instance in the Save Set attribute, replace the backslash with its 
URL encoded value, which is %5C. In the following example, a SQL Server named 
instance that is identified as:

CORPDBSERV1\YUKON

would be represented in the Save Set attribute as:

CORPDBSERV1%5CYUKON

To backup only the database named NADATA in the SQL Server named instance 
CORPDBSERV1\YUKON, the complete entry in the Save Set attribute would be:

APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON\NADATA

If the database name in the previous example was NA#DATA, the save set entry 
would be:

APPLICATIONS:\SqlServerWriter\CORPDBSERV1%5CYUKON\NA%23DATA

Table 8 lists the most commonly used special characters and their URL values.

Table 8 Special characters and their URL encoded values

Special character URL encoded value Special character URL encoded value

\ %5C ? %3F

/ %2F ] %5D

" %22 [ %5B

% %25 } %7D

# %23 { %7B

& %26 ^ %5E

< %3C ‘ %60

> %3E | %7C
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Application information variable settings
Table 9 lists the variables that can be specified in the Application information 
attribute of the Client resource. 

Table 9 Application information variable settings (1 of 2)

Attribute Name Description Values

All snapshots

NSR_SNAP_TYPE=value Specifies the snapshot service 
provider name.

• vss
This value is required.

NSR_DATA_MOVER=value Specifies the hostname of the 
NetWorker VSS client that moves 
snapshots from the NetWorker VSS 
client to primary and secondary 
(conventional) storage. The host can 
be either a local host or a proxy 
client host.

• The local host
• The proxy client hostname
If no value is entered, the local host is 
used as the data mover.
If you are setting up a proxy client for a 
virtual cluster server, you must also type 
the proxy client hostname in the Remote 
Access attribute of the Client resource.
For serverless backups, specify a proxy 
client.
If setting up an Exchange client resource, 
it is recommended that you use a proxy 
client. If a proxy client is specified, 
Exchange consistency checks are 
performed on the proxy client. Related 
messages are written to the Replication 
Manager log files 
(erm_clientxx.log) on the 
proxy client.
If no proxy client is specified for an 
Exchange client resource, consistency 
checks are performed on the client 
resource host. Related messages are 
logged on the client resource host in both 
the Replication Manager log files and the 
vssclient.log file.
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Task 6: Configure privileges
The NetWorker VSS client must be granted NetWorker Administrator privileges in 
order to perform media database operations during snapshot deletion. If you set up a 
proxy client for the NetWorker VSS client, grant the proxy client NetWorker 
Administrator privileges. If you are setting up a NetWorker VSS client in a cluster, 
grant NetWorker administrator privileges to each cluster node and virtual server.

To add configure privileges:

1. In the Administration window of the NetWorker Management Console, click 
Configuration.

2. In the expanded left pane, click User Groups.

3. Right-click the Administrators group, then select Properties.

The Properties dialog box appears.

4. In the Users attribute, add the following values for the NetWorker VSS client 
host. Place each value on a separate line:

user=administrator,host=VSS_client_host

user=system,host=VSS_client_host

Where VSS_client_host is the DNS hostname of the NetWorker VSS client.

Exchange snapshots

NSR_DM_PORT=value Specifies the control port number to 
use in communicating with the data 
mover client. This is the control port 
that the Replication Manager (RM) 
client service is running on.
For more information about RM 
ports, refer to the EMC NetWorker 
VSS Client for Windows First Edition 
Installation Guide.

• The RM client control port number. 
For example:
NSR_DM_PORT=6728

An RM client control port number must 
be specified. 

NSR_ALT_PATH=value Specifies the path on which to 
mount Exchange snapshots during 
the backup process. Exchange 
snapshots are mounted so that the 
database consistency check utility, 
eseutil.exe can be run. 

• A mount path. 
For example:
NSR_ALT_PATH=G:\mount_replica\

If a proxy client is specified in the 
NSR_DATA_MOVER attribute, enter the 
mount path on the proxy client.

NSR_CHECK_JET_ERRORS
=value

Specifies which JET database 
errors to check for in the event log 
before taking a snapshot.

Note: If errors are found, the 
snapshot will fail.

• 1018
• 1019
• 1022
• all
• none
Values can be separated with a comma, 
for example:
NSR_CHECK_JET_ERRORS=1018,
1019
The default is all.

Table 9 Application information variable settings (2 of 2)

Attribute Name Description Values
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If a proxy client is set up for the NetWorker VSS client, add the following values:

user=administrator,host=VSS_clientproxy_host

user=system,host=VSS_clientproxy_host

If the NetWorker VSS client is installed in a cluster, grant NetWorker 
administrator privileges to each cluster node and virtual server.

5. Click OK.

Task 7: Configure a proxy client
A proxy client is a separate host that acts as a data mover for a NetWorker VSS client. 
By default, the NetWorker VSS client acts as its own data mover. However, a proxy 
client is required for serverless backups. Serverless backups free the NetWorker VSS 
client from much of the processing involved in a snapshot backup. In a serverless 
backup, a snapshot is created on the NetWorker VSS client and then immediately 
moved to the proxy client for further processing.

A proxy client can also be set up on a NetWorker storage node. In this way network 
traffic that is generated when a snapshot is rolled over to a conventional backup 
medium is avoided.

Table 10 lists the requirements for setting up a proxy client. 

Table 10 Configuration requirements for a proxy client (1 of 2)

Requirement Description

General requirements

Installation The proxy client must have the same version of the NetWorker VSS client 
software as the host for which it is acting as the proxy client. For more 
information, refer to the EMC NetWorker VSS Client for Microsoft Windows 
Server 2003 First Edition Installation Guide.

Configuration Create a NetWorker VSS client resource for the proxy client host. For more 
information, see “Task 5: Configure a Client resource” on page 38.

Type the proxy client host name in the Application Information and the 
Remote Access attributes of the NetWorker VSS client resource that will use 
the services of the proxy client. 

Connectivity The proxy client must have connectivity between the NetWorker VSS client, 
the NetWorker server, and the storage subsystem on which snapshots reside.

Serverless 
backups

A proxy client is required for serverless backups. 
Additionally, serverless backups are supported only with VSS hardware 
providers and depend on the capabilities of the storage subsystem. For the 
EMC VSS Provider, serverless backups are supported for both CLARiiON and 
Symmetrix storage systems.

Rollback recovery The NetWorker VSS client to which the snapshot is to be rolled back must be 
supported with a proxy client. For more information rollback requirements, see 
“Roll back a snapshot” on page 80.

EMC CLARiiON For proxy clients using EMC CLARiiON storage and the EMC VSS Provider, at 
least one CLARiiON LUN must be permanently assigned to the proxy host.

Third-party 
hardware 
providers

Hardware providers may have additional configuration requirements for proxy 
clients. Refer to the vendor’s product documentation for details on these 
requirements.
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Backing up a clustered NetWorker VSS client
To configure a virtual NetWorker VSS client for backup, complete all of the tasks 
required to backup a regular NetWorker VSS client. However, there are some 
considerations to be aware of when setting up a virtual NetWorker VSS client. 
Table 11 on page 46 outlines the considerations that are unique to setting up a 
clustered NetWorker VSS client. 

Cluster failover and backups
If a node within a cluster undergoes failover during a backup operation, the 
operation will not be successful. The next scheduled backup operation will be the 
next valid backup.

If you are using a hardware provider such as the EMC VSS Provider, use the disk 
management utilities provided with the associated hardware to delete any resources 
that may be left in an indeterminate state as a result of the failed backup. For 
example, a CLARiiON storage solution may have an InActive snapshot as the result 

Additional requirements for an Exchange server

Exchange 
performance

Set up a proxy client for an Exchange server. A proxy client performs the 
processing associated with the Exchange consistency checker utility, 
eseutil.exe, thus reducing the load on the Exchange server.

Consistency 
checker utility

The Exchange consistency checker utility, eseutil.exe, must be installed on the 
proxy client. The version of eseutil.exe, must be of the same version (service 
pack level) as the Exchange server. For example, if Exchange Server 2003 
Service Pack 2 is installed on the Exchange server, then the version of 
eseutil.exe that is installed on the proxy client must be from the Exchange 
Server 2003 SP2 Management utilities. Failure to do so will cause the 
consistency checker utility to report errors even when the databases are valid.
Install the eseutil.exe utility from the Exchange Management Tools located on 
the Exchange Server CD.

Installation path to 
consistency 
checker utility 

If the installation of the Exchange consistency checker utility, eseutil.exe, is 
not performed from the Exchange installation program, ensure that the path to 
the eseutil.exe program is in the $PATH environment variable.

Exchange mount 
paths

Use the NSR_ALT_PATH variable to specify a path to mount snapshots on the 
proxy client. For more information, see “Application information variable 
settings” on page 43.

Table 10 Configuration requirements for a proxy client (2 of 2)

Requirement Description

Table 11 Additional steps and considerations for backing up a clustered client resource

Backup task Consideration

“Task 5: Configure a Client 
resource”

Configure a Client resource for each virtual server that is being backed up and 
each physical node in the cluster on which the virtual server may execute.

Type the names of the physical nodes of the cluster in the Remote Access 
attribute of each virtual Client resource.

“Task 6: Configure privileges” Set up NetWorker administrator privileges for each physical node and proxy 
client in the cluster.

“Task 7: Configure a proxy client” If a hardware provider such as the EMC VSS Provider is being used, a proxy 
client must be configured for a clustered NetWorker VSS client.
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of a failed backup. In this case, use the EMC Navisphere® user interface or the 
NaviCLI command line interface to search for and delete the inactive snapshot.

Moving a NetWorker VSS client to another NetWorker server
Do not set up scheduled backups for a NetWorker VSS client on multiple NetWorker 
servers. A NetWorker VSS client should be protected by only one NetWorker server.

To move a NetWorker VSS client to a different NetWorker server:

1. On the NetWorker server that you are moving from, disable or delete the client 
resources that are set up for the NetWorker VSS client.

You can disable a client resource for scheduled backup by unselecting the 
Scheduled backup attribute in the client resource.

2. On the NetWorker VSS client, open the NetWorker VSS client software and 
manually delete any snapshots for the client. For information about deleting 
snapshots manually, see “Delete a snapshot” on page 83.

Before deleting the snapshots, you can manually roll them over to a conventional 
backup. In this way, the data in the snapshot can be recovered.

3. On the NetWorker server that you are moving to, set up scheduled backups for 
the NetWorker VSS client. For more information, see “Backup configuration 
roadmap” on page 30
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Performing a recovery
Review the following items before completing the procedures in this section:

◆ To recover Active Directory (AD) data, see Chapter 5, ”Active Directory Recover.”

◆ To recover data from a persistent snapshot that has not been rolled over to a 
conventional backup medium, see “Recovering file system snapshots that have 
not been rolled over” on page 59.

◆ To recover data, you must be a member of the following:

• The NetWorker server Administrator’s group. For information about adding 
users to the NetWorker server Administrator’s group, refer to the EMC 
NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide or later.

• Either the Windows Administrators group or the Windows Backup Operators 
group.

◆ To recover backup data that was password-protected and encrypted with a 
non-NetWorker VSS Client, use the recover.exe command from the CLI 
(command line interface). For more information about the recover.exe command, 
refer to the NetWorker Command Reference Guide, release 7.3.2 or higher.

◆ Mount points:

• Data that was backed up from a mount point is available for browsing at the 
root of the navigation tree. For example, if the drive H:\ has a mount point 
named H:\CAD_Drawings, then a separate entry for the mount point 
H:\CAD_Drawings will be available at the root of the navigation tree instead 
of as a subfolder under H:\.

• To recover data to a mount point that has been deleted, manually re-create the 
mount point before recovering the data. Otherwise, the data will be recovered 
to a local directory whose name corresponds to the deleted mount point.

• If the disk that is referenced by the mount point has been replaced, manually 
re-create the mount point.

◆ If a file was not backed up due to a skip directive, you may still be able to select 
the file for a recovery operation. In this case, although you can select the file, it is 
not recoverable.

CAUTION

If you are recovering File Replication Services (FRS) or NT Directory Services 
(NTDS) data, boot the NetWorker client in Directory Service Recovery mode 
before completing the recovery options in this section. For more information, see 
“Booting Windows in Directory Service Restore mode” on page 65.

To recover system data:

1. Open the NetWorker VSS client software and select the NetWorker server on 
which the NetWorker VSS client was configured for backup. 

2. If the NetWorker VSS client is part of a cluster, select the virtual client to which 
you are recovering data. The virtual client can be selected from the Client list 
attribute in the application toolbar.

3. From the left pane, select Recover > System Recover Session.
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4. In the Navigation Tree, select the items to be recovered. 

By default, items displayed in the Navigation Tree are from the most recent 
backup. For the System Recover Session view, both snapshot and rollovers can be 
displayed in the same view. 

• If the most recent backup for an item is a snapshot, the snapshot is displayed.

• If the most recent backup for an item is a rollover, the rollover is displayed.

To recover file system items from a previous backup:

• From the application toolbar, click the Browse calendar icon and select an 
earlier browse time.

• To view versions of a backup item prior to the browse time, right-click on an 
item in the Navigation Tree and select Versions from the pop-up menu.

5. To determine whether any volumes need to be mounted for a selected item, 
right-click the item and select Required Volumes from the pop-up list. 

6. From the Options menu, select System Recover Session Options.

7. For information about options and considerations that correspond to the type of 
data to be recovered, see:

• “NetWorker recovery options” on page 51

• “Exchange recovery options” on page 52

• “ADAM recovery options” on page 53

• “DFS recovery options” on page 54

• “FRS recovery options” on page 55

• “NTDS recovery options” on page 56

• “SQL data recovery” on page 57

8. From the System Recover Session toolbar, click Start Restore.

9. From the left pane, select Monitor to view messages related to the progress of the 
recovery operation.

Note: If you recovered items from a snapshot (instant recovery), the snapshot volume will be 
temporarily mounted during the recovery operation. The mounted volume is displayed in the 
Windows Explorer program. After the recovery is complete, you may have to refresh the 
Windows Explorer to update its view.

NetWorker recovery options
To specify recovery options for file system data:

1. From the Options menu, select System Recover Session Options.

2. Select the NetWorker tab.

3. In the Relocate recovered data to: field, type a location other than the location 
from which the data was originally backed up. 

The location must be a local path. URL syntax such as \\servername\share is 
not supported.
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4. Use the Restore Type field to determine the default recovery method.

• Select Conventional Restore to recover from a conventional backup medium. 
If a conventional backup is not available for the selected browse time, an 
instant recovery is performed.

• Select Instant Restore to recover from a snapshot. If a snapshot is not available 
for the selected browse time, a conventional backup is performed.

For instant restore, snapshot validation will occur prior to the restore.  If the 
snapshot is invalid, the restore will fail.  The invalid snapshot will be deleted 
automatically the next time the snapshot group runs. You can also delete a 
snapshot manually. For more information, see “Delete a snapshot” on page 83.

5. Select Use Microsoft best practices for selecting the system state to enforce 
Microsoft recommendations that determine which system state items must be 
selected as a group for recovery. Unselect this attribute to select system state items 
individually. 

There are some procedures, such as recovering Distributed File System (DFS) 
data, where you can unselect this attribute. However, unless instructed to do so, it 
is recommended that this attribute be selected. After each recovery operation, this 
option is automatically selected.

6. Click OK.

For more information about recovering data, see “Performing a recovery” on page 50.

Exchange recovery options
The following requirements must be met before recovering Microsoft Exchange data:

◆ The APPLICATIONS:\Microsoft Exchange Writer\ save set must have been 
backed up. For more information, see Chapter 2, ”Configuring a Scheduled 
Backup.”

◆ For each Exchange database to be recovered, the Exchange checkbox titled This 
database can be overwritten by a restore must be selected in the Exchange 
SYSTEM Manager application. This is a Microsoft requirement. For information 
about this checkbox, refer to the Microsoft Exchange documentation.

◆ When new Microsoft Service Packs for Exchange Server are installed, transactions 
(log files) created with previous Service Pack versions of Exchange Server can 
generally not be recovered onto the updated Exchange server.  Microsoft 
sometimes provides hotfix kits to address this Microsoft restriction.

◆ If you are recovering Exchange data that was backed up from a legacy NetWorker 
client by using the save set VSS USER DATA:\, then the Exchange databases to 
which data is being recovered must be unmounted before the recovery operation. 
After the recovery, the databases must be mounted.

To specify recovery options for Exchange data:

1. From the Options menu, select System Recover Session Options and then select 
the Exchange tab.

2. Select the type of recovery to perform.

• To recover Exchange data and to retain all existing Exchange transactions that 
occurred after the time of backup, select Include existing logs (Roll forward 
recovery). 
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• To recover Exchange data up to the time of backup only and to not include 
subsequent transactions, select Include logs only from this restore 
(Point-in-time recovery). If you select point-in-time recovery, you cannot 
select an individual database for recovery. However, you can select to recover 
items at the Storage Group level or higher.

CAUTION

If you perform a roll-forward recovery, perform a full backup after the 
recovery. Doing so enables you to recover data to a point-in-time that is after 
the point-in-time of the roll-forward recovery, if necessary. 

Also be aware that a roll-forward recovery is not possible after performing a 
point-in-time recovery.

3. To make the Exchange database available after the recovery, select Put databases 
online after restore.

4. Click OK to close the System Recover Session Options dialog box.

5. From the Navigation Tree, expand the Applications folder and the Microsoft 
Exchange Writer folder.

6. Select the Exchange storage groups and databases that are to be recovered.

7. From the System Recover Session toolbar, click Start Restore.

For more information about recovering system data, see “Performing a recovery” on 
page 50.

ADAM recovery options
You can specify whether to perform an authoritative or nonauthoritative recovery of 
Active Directory Application Mode (ADAM) data on this host.

A nonauthoritative recovery restores the most recent ADAM data from backups and 
then updates the recovered host with the most recent ADAM data from another 
ADAM server in the domain. A nonauthoritative recovery relies on at least one other 
ADAM server in the domain to have accurate, up-to-date ADAM data. 
Nonauthoritative recoveries are typically performed when the host is being 
recovered due to catastrophic loss of data such as a disk failure. A nonauthoritative 
recovery is performed by default.

An authoritative recovery restores the most recent ADAM data from backups, and 
then updates other ADAM servers in the domain with the recovered data. Perform an 
authoritative recovery only when corrupted or deleted ADAM data has been 
propagated to other ADAM servers.

Note: To recover ADAM data, the APPLICATIONS:\ADAM (instancename) Writer\ save set 
must have been backed up. For more information, see Chapter 2, ”Configuring a Scheduled 
Backup.”
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To specify recovery options for ADAM (Active Directory Application Mode) data:

1. From the Options menu, select System Recover Session Options and then select 
the ADAM tab.

2. Select one of the following options:

• Non Authoritative restore to perform a nonauthoritative recovery. 

• Authoritative Restore to perform an authoritative recovery.

3. Click OK to close the System Recover Session Options dialog box.

4. In the Navigation Tree, expand the Applications folder and select ADAM 
(instancename) Writer.

5. From the System Recover Session toolbar, click Start Restore.

For more information about recovering system data, see “Performing a recovery” on 
page 50.

DFS recovery options
You can specify whether to perform an authoritative or nonauthoritative recovery of 
Distributed File System (DFS) data on this host.

A nonauthoritative recovery restores the most recent DFS data from backups and 
then updates the recovered host with the most recent DFS data from another DFS 
server in the domain. A nonauthoritative recovery relies on at least one other DFS 
server in the domain to have accurate up-to-date DFS data. Nonauthoritative 
recoveries are typically performed when the host is being recovered due to 
catastrophic loss of data such as a disk failure. A nonauthoritative recovery is 
performed by default.

An authoritative recovery restores the most recent DFS data from backups, and then 
updates other DFS servers in the domain with the recovered data. Perform an 
authoritative recovery only when corrupted or deleted DFS data has been propagated 
to other DFS servers.

Note: To recover DFS data, the APPLICATIONS:\DFS Replication service writer save set must 
have been backed up. The DFS Replication service writer is available with Windows Server 
2003 R2 or later. Additionally, the SYSTEM COMPONENTS:\ save set on the namespace server 
(usually the domain controller) that is associated with the DFS configuration must have been 
backed up. For more information, see Chapter 2, ”Configuring a Scheduled Backup.”

To specify whether to perform an authoritative or nonauthoritative recovery:

1. From the Options menu, select System Recover Session Options and then select 
the DFS tab.

2. Select one of the following options:

• Non Authoritative Restore to perform a nonauthoritative recovery.

• Authoritative Restore to perform an authoritative recovery.

3. Click OK to close the System Recover Session Options dialog box.

4. From the Navigation Tree, expand the Applications folder and select DFS 
Replication service writer.

5. From the System Recover Session toolbar, click Start Restore.
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6. After the DFS Replication service writer has been recovered, you must recover the 
Bootable System State components on the namespace server (usually the domain 
controller) that is associated with the DFS configuration.

a. Boot the namespace server in directory service restore mode as described in 
“Booting Windows in Directory Service Restore mode” on page 65.

b. Open the NetWorker VSS client software on the namespace server (usually the 
domain controller) that is associated with the DFS configuration.

c. From the Options menu, select System Recover Configuration Options and 
then click the NetWorker tab.

d. Unselect the Use Microsoft best practices for selecting the system state 
attribute and click Yes when asked to confirm your selection.

e. Click OK to close the dialog box.

f. From the left pane, select Recover > System Recover Session

g. From the Navigation Tree, expand the SYSTEM COMPONENTS folder and 
select BootableSystemState.

h. From the System Recover Session toolbar, click Start Restore.

After the recovery has completed, the Use Microsoft best practices for 
selecting the system state attribute is automatically selected.

For more information about recovering system data, see “Performing a recovery” on 
page 50.

FRS recovery options
You can specify whether to perform an authoritative or nonauthoritative recovery of 
File Replication Services (FRS) data on this host.

CAUTION

Boot the NetWorker client in Directory Service Recovery mode before completing 
the recovery options in this section. For more information, see “Booting Windows 
in Directory Service Restore mode” on page 65.

A nonauthoritative recovery restores the most recent FRS data from backups and then 
updates the recovered host with the most recent FRS data from another FRS server in 
the domain. A nonauthoritative recovery relies on at least one other FRS server to 
have accurate up-to-date FRS data. Nonauthoritative recoveries are typically 
performed when the host is being recovered due to catastrophic loss of data such as a 
disk failure. A nonauthoritative recovery is performed by default.

An authoritative recovery restores the most recent FRS data from backups, and then 
updates the other FRS servers in the domain with the recovered data. Perform an 
authoritative recovery only when corrupted or deleted FRS data has been propagated 
to other FRS servers.

Note: To recover FRS data, the SYSTEM COMPONENTS save set must have been backed up. 
For more information, see Chapter 2, ”Configuring a Scheduled Backup.”
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To specify whether to perform an authoritative or nonauthoritative recovery:

1. From the Options menu, select System Recover Session Options and then select 
the FRS tab.

2. Select one of the following options:

• Non Authoritative restore to perform a nonauthoritative recovery. 

• Authoritative Restore to perform an authoritative recovery.

3. Click the NetWorker tab and then unselect the attribute titled Use Microsoft best 
practices for selecting the system state. Click Yes when asked to confirm your 
selection.

4. Click OK to close the System Recover Session Options dialog box.

5. From the Navigation Tree, expand the System Components folder and select 
FRS.

6. From the System Recover Session toolbar, click Start Restore.

If you are performing an authoritative recovery, complete the remaining steps in 
“Performing an authoritative recovery of NTDS or FRS data” on page 66.

For more information about general recovery options, see “Performing a recovery” 
on page 50.

NTDS recovery options
You can specify whether to perform an authoritative or nonauthoritative recovery of 
NT Directory Services (NTDS) data on this host.

CAUTION

Boot the NetWorker client in Directory Service Recovery mode before completing 
the recovery options in this section. For more information, see “Booting Windows 
in Directory Service Restore mode” on page 65.

A nonauthoritative recovery restores the most recent NTDS data from backups and 
then updates the recovered host with the most recent NTDS data from another NTDS 
server in the domain. A nonauthoritative recovery relies on at least one other NTDS 
server to have accurate up-to-date NTDS data. Nonauthoritative recoveries are 
typically performed when the host is being recovered due to catastrophic loss of data 
such as a disk failure. A nonauthoritative recovery is performed by default.

An authoritative recovery restores the most recent NTDS data from backups, and 
then updates other NTDS servers in the domain with the recovered data. Perform an 
authoritative recovery only when corrupted or deleted NTDS data has been 
propagated to other NTDS servers.

Note: To recover NTDS data, the SYSTEM COMPONENTS save set must have been backed up. 
For more information, see Chapter 2, ”Configuring a Scheduled Backup.”
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To specify whether to perform an authoritative or nonauthoritative recovery:

1. From the Options menu, select System Recover Session Options and then select 
the NTDS tab.

2. Select one of the following options:

• Non Authoritative restore to perform a nonauthoritative recovery. 

• Authoritative Restore to perform an authoritative recovery.

3. Click the NetWorker tab and then unselect the attribute titled Use Microsoft best 
practices for selecting the system state. Click Yes when asked to confirm your 
selection.

4. Click OK to close the System Recover Session Options dialog box.

5. From the Navigation Tree, expand the System Components folder and select 
NTDS.

6. From the System Recover Session toolbar, click Start Restore.

If you are performing an authoritative recovery, complete the remaining steps in 
“Performing an authoritative recovery of NTDS or FRS data” on page 66.

For more information about general recovery options, see “Performing a recovery” 
on page 50.

SQL data recovery
The following requirements must be met to recover SQL databases:

◆ To recover SQL 2000 embedded databases, the SYSTEM COMPONENTS:\ save 
set must have been backed up.

◆ To recover SQL2000 standalone databases, the 
APPLICATIONS:\ MSDEWriter-SQL2000\ save set must have been backed up.

◆ To recover SQL 2005 standalone or express databases, either the 
APPLICATIONS:\ MSDEWriter-SQL2000\ save set or the 
APPLICATIONS:\ SQLServerWriter\ save set must have been backed up.

Recovering SQL 2000 embedded databases
To recover SQL 2000 embedded databases:

1. Stop the SQL Server services for the SQL 2000 embedded database instances

2. From the Options menu, select System Recover Configuration Options and then 
click the NetWorker tab.

3. Unselect the attribute titled, Use Microsoft best practices for selecting the 
system state and click Yes when asked to confirm your selection.

4. Click OK to close the dialog box.

5. From the left pane, select Recover > System Recover Session

6. From the Navigation Tree, expand the SYSTEM COMPONENTS folder and the 
MSDEWriter folder.

7. Select the databases to recover.

8. From the System Recover Session toolbar, click Start Restore.

9. After the recovery is complete, start the SQL Server services for the SQL 2000 
embedded database instances.
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Recovering SQL 2000 standalone databases
To recover SQL 2000 standalone databases:

1. Stop the SQL Server services for the SQL 2000 standalone database instances.

2. From the Navigation Tree, expand the Applications folder and the 
MSDEWriter-SQL2000 folder.

3. Select the databases to recover.

4. From the System Recover Session toolbar, click Start Restore.

5. After the recovery is complete, start the SQL Server services for the SQL 2000 
standalone database instances.

Recovering SQL 2005 databases
If the SQL Server VSS Writer service was enabled during backup, then SQL 2005 
express and standalone databases must be recovered from the SQLServerWriter save 
set. The SQL Server VSS Writer service is disabled by default when Microsoft SQL 
Server 2005 is installed. If the SQL Server VSS Writer service was disabled during 
backup, then SQL 2005 express and standalone databases must be recovered from the 
MSDEWriter-SQL2000 save set. In this case, follow the second set of steps in this 
section.

To recover SQL 2005 standalone or express databases that were backed up to the 
SQLServerWriter save set:

1. If restoring the master database, stop the SQL Server services for the SQL 2005 
database instances.

2. From the Navigation Tree, expand the Applications folder and the 
SQLServerWriter folder.

3. Select the databases to recover.

4. From the System Recover Session toolbar, click Start Restore.

5. After the recovery is complete, start the SQL Server services for the SQL 2005 
database instances.

To recover SQL 2005 standalone or express databases that were backed up to the 
MSDE-Writer-SQL2000 save set:

1. Stop the SQL Server services for the SQL 2005 database instances.

2. From the Navigation Tree, expand the Applications folder and the 
MSDEWriter-SQL2000 folder.

3. Select the databases to recover.

4. From the System Recover Session toolbar, click Start Restore.

5. After the recovery is complete, start the SQL Server services for the SQL 2005 
database instances.
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Recovering file system snapshots that have not been rolled over
The procedure to recover items in a file system snapshot differs depending on 
whether the snapshot has been rolled over to a conventional storage medium. This 
section describes how to recover items from a file system snapshot that has not been 
rolled over. For information about recovering file system snapshots that have been 
rolled over, see “Performing a recovery” on page 50.

Note: If a snapshot volume has been mounted using a non-NetWorker VSS client utility such as 
the EMC NaviCLI interface or the Windows Disk Management utility, remove the mount point 
before performing the next backup or recovery operation. If the mount point is not removed, it 
will be removed at the end of the next NetWorker backup or recovery operation.

To recover items in a file system backup that has not been rolled over:

1. Connect to the NetWorker server on which the NetWorker client was configured 
for backup. For more information, see “Opening the software and connecting to a 
NetWorker server” on page 25.

2. From the left pane, select Recover > System Recover Session.

3. In the Navigation Tree, right-click the snapshot and select Mount Snapshot.

If the Mount Snapshot option is unavailable, then the snapshot has been rolled 
over. In this case, follow the steps described in “Performing a recovery” on 
page 50.

If another snapshot is currently mounted, a message displays that indicates that 
the currently mounted volume will be unmounted. Click OK to unmount the 
volume and to proceed with mounting the selected snapshot volume.

4. When the task bar animation stops and a green mark appears, click on the 
mounted snapshot.

The mounted snapshot item will expand in the Navigation Tree.

5. Under the expanded snapshot, select the items to be recovered. For more 
information about selecting items for recovery, see “Selecting an item for 
recovery” on page 26. 

6. Select any additional file system options if applicable. For more information, see 
“NetWorker recovery options” on page 51.

7. From the System Recover Session toolbar, click Start Restore.

Once the recovery starts, the snapshot is automatically unmounted.

8. From the left pane, select Monitor to view the progress of the recovery.
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Performing a disaster recovery of the VSS client
The following disaster recovery scenarios are included in this section: 

◆ “Performing an ASR disaster recovery” on page 60

◆ “Performing a disaster recovery of a clustered client” on page 64

Performing an ASR disaster recovery
ASR recovery should be used only if the failed computer requires a full disaster 
recovery (for example, if the system drive has failed). 

An ASR recovery requires the following: 

◆ A rolled over (conventional) backup of the SYSTEM COMPONENTS save set and 
the system volumes such as C:\ and D:\. A rolled over backup of the All save set 
automatically includes these required items.

◆ The Microsoft Windows Server 2003 installation CD for the computer you are 
recovering. ASR does not support recovery CDs of the original equipment 
manufacturer (OEM).

◆ The latest NetWorker rollover backup for the computer you are recovering.

If conventional NetWorker backup media is moved to an offsite location, ensure 
that all necessary volumes are available before starting the recovery. To list the 
media associated with the files to recover, run mminfo -mv from the command 
prompt. For more information about the mminfo command, refer to the 
NetWorker Command Reference Guide, release 7.3.2 or higher.

◆ Be aware of the limitations that are described in “ASR recovery limitations” on 
page 61.

Notes: 
If the ASR recovery fails with an error message similar to the following, use the legacy 
NetWorker disaster recovery method. For procedures, refer to the EMC NetWorker Release 7.3.2 
Multiplatform Version Disaster Recovery Guide:

The recovery application "C:\WINDOWS\system32 \asr_pfu.exe 
/restore /sifpath=C:\WINDOWS\repair\asr.sif" returned an error 
code 0x2. Since this indicates an unrecoverable error, ASR 
cannot continue on this machine.

If you use the legacy disaster recovery method, you may not be able to log in to the host using 
a domain account. In this case, rejoin the local host to the domain. Refer to Microsoft 
documentation for information about rejoining a host to a domain. 

Snapshot recovery is not supported for ASR or legacy disaster recoveries. If you use the legacy 
disaster recovery method, you may see snapshot entries in the NetWorker VSS client 
Navigation tree. However, if the snapshot was on a volume that was lost due to a disaster, you 
cannot select the snapshot for a recovery operation.

ASR recovery consists of the following tasks:

◆ “Task 1: Create the ASR disk media set” on page 61

◆ “Task 2: Perform the ASR recovery” on page 62

◆ “Task 3: Complete special handling of components” on page 62

◆ “Task 4: Verify the ASR recovery” on page 63
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ASR recovery limitations
The following limitations apply to ASR recoveries:

◆ Recovery CDs from original equipment manufacturers (OEM) are not supported.

Manufactures, such as Hewlett Packard and IBM provide a recovery CD or DVD 
with each system. These recovery disks cannot be used to perform an ASR 
recovery. To perform an ASR recovery, you must have an official Microsoft 
Windows installation CD.

◆ FAT16 partitions are not supported.

After you have completed the ASR recovery and rebooted, recover a FAT16 
partition in a separate, non-ASR NetWorker recovery operation. For more 
information, see “Performing a recovery” on page 50.

◆ Vendor-specific drivers must be installed after Windows installation.

ASR recovery can only be done on hardware components supported by the 
Windows installation media. Drivers for vendor-specific hardware must be 
installed after the Windows installation is complete.

For example, the IBM Thinkpad network interface card (NIC) is not supported by 
the Windows installation media, and will cause ASR recovery to fail. For more 
information on hardware supported by the Windows installation media, refer to 
the Microsoft documentation.

Task 1: Create the ASR disk media set
To create an ASR disk media set: 

1. Open the NetWorker VSS client software on any backup client and connect to the 
NetWorker server on which the failed client was configured for backup. For more 
information, see “Opening the software and connecting to a NetWorker server” 
on page 25.

2. From the left pane, select Recover > System Recover Session.

3. From the System Recover Session toolbar, click ASR Disk Wizard.

4. From the list of clients, select the client to be recovered. The local client is selected 
by default.

The files for the ASR disk are saved in the temp directory on the local client.

Note: The ASR Disk Wizard only supports recovery of conventional (rolled over) save sets.  
If the required save sets have not been rolled over, the client will not be available for 
selection.

5. When prompted, insert a blank disk into the A:\ drive and click OK.

6. When prompted about pausing the ASR recovery to select which save sets to 
restore, choose one of the following options:

Yes — During recovery, ASR pauses and prompts you for the save sets to restore. 
If the ASR save set was backed up as a component of save set All, all of the client’s 
save sets can be selected for recovery except for application data save sets such as 
SQL or Exchange save sets.

No — ASR performs a fully automated recovery of the NetWorker client host 
computer, without a pause. If the ASR save set was backed up as a component of 
save set All, all of the client’s save sets are recovered except for application data 
save sets such as SQL or Exchange save sets.
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7. When notified that the ASR disk has been created successfully, remove the disk 
from the A:\ drive and label it.

8. Complete the wizard screens to create an ASR disk media set.

Task 2: Perform the ASR recovery
To perform an ASR recovery on a NetWorker VSS client:

1. Start the computer from the Windows Server 2003 installation CD. 

You may need to run the BIOS setup program to configure the computer to boot 
from the CD-ROM drive. For instructions, refer to the computer manufacturer’s 
documentation.

2. If prompted, press a key to boot from the CD-ROM drive.

3. During the text-mode phase of Windows setup, watch the lower portion of the 
screen. When prompted, press [F2] to display the ASR Recovery menu. Follow 
the instructions on the screen.

4. When prompted, insert the first ASR disk into the A:\ drive and press a key to 
continue. ASR formats the system partition, copies files, and begins the Windows 
installation.

If multiple diskettes are required for recovery, the recovery process may not 
prompt explicitly for the next diskette. Instead, a message might appear that is 
identical to the message that prompted you to insert the ASR diskette at the 
beginning of the recovery procedure. In this case, insert the next diskette and 
press any key to continue.

5. If you did not select the "pause during recovery" option while creating the ASR 
disk media set, a fully automated recovery is performed. 

If you selected the "pause during recovery" option while creating the ASR disk 
media set, the NetWorker ASR Client dialog box appears during the graphical 
phase of the Windows installation. 

a. Expand My Computer to view the save sets to recover. The required save sets 
are selected by default.

b. Click Continue.

By default, the displayed save sets represent the most recent backup. 

6. To view and select previous backups, click the Browse calendar icon in the 
application toolbar and select an earlier browse time.

CAUTION

Certain components cannot be correctly recovered during ASR recovery. To recover 
these components, see “Task 3: Complete special handling of components” on 
page 62.

Task 3: Complete special handling of components
Due to limitations in Microsoft ASR functionality, the following system state 
components cannot be correctly recovered during ASR recovery:

◆ COM+ Registration Database

◆ Disk Quota Database

◆ Windows Management Instrumentation Database

◆ VSS writers
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To recover these components, perform the following procedure after an ASR 
recovery:

1. Start the NetWorker VSS client program.

If you are recovering a domain controller, boot the host in Directory Services 
Restore Mode mode before starting the NetWorker VSS client program.

2. From the application toolbar, click the NetWorker server icon to select the 
NetWorker server on which the NetWorker client was configured for backup. For 
more information, see “Opening the software and connecting to a NetWorker 
server” on page 25.

3. From the left pane, select Recover > System Recover Session.

4. Select the required items for recovery. To view and select previous backups, click 
the Browse calendar icon in the application toolbar and select an earlier browse 
time.

For backups created with the NetWorker VSS client:

• From the Navigation Tree, open the System Components folder and select all 
items for recovery except for ASR Disk.

For backups created with a pre-NetWorker VSS client where VSS was licensed and 
enabled:

• Select all VSS save sets for recovery, except VSS ASR DISK.

For backups created with a pre-NetWorker VSS client where VSS was not licensed 
and enabled:

a. From the Navigation Tree, expand the SYSTEM STATE save set folder and 
check for the presence of the COM+ Registration Database component. If it is 
present, select the SYSTEM STATE save set folder for recovery.

b. Expand the SYSTEM DB save set and check for the presence of the Disk 
Quota Database and the Windows Management Instrumentation Database. 
If either is present, select the SYSTEM DB save set folder for recovery.

5. From the System Recover Session toolbar, click Start Restore.

Task 4: Verify the ASR recovery
To verify the NetWorker client recovery:

1. Reboot the NetWorker client computer and verify that the NetWorker Remote 
Exec and NetWorker Power Monitor services have started.

You can disable the NetWorker Power Monitor service if it is not needed. For 
more information, refer to the EMC NetWorker, Release 7.3.2, Multiplatform Version, 
Administration Guide or later.

2. Use the Windows Event Viewer to examine the event logs for errors. In particular, 
check for the following:

• Service startup errors that are related to the Windows system state

• Errors regarding the recovery of Windows system-protected files

For information about how the NetWorker software handles the Windows system 
state and system-protected files, refer to the EMC NetWorker, Release 7.3.2, 
Multiplatform Version, Administration Guide or later.

3. Verify that any applications (such as Microsoft Office) that were running prior to 
the disaster have been properly recovered. To verify:
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a. Run each application.

b. Open a previously saved document.

Performing a disaster recovery of a clustered client 
The following procedure describes how to recover a single node in a two node cluster. 
The procedure assumes that you are recovering Node_B and that Node_A is 
available.

1. Using the Cluster Administrator on Node_A, evict Node_B from the cluster.

2. At the command prompt, type the following to clean up MSCS:

cluster node Node_B /forcecleanup

CAUTION

After cleaning up the Cluster Server, You must reproduce the preexisting 
application environment on Node_B so MSCS can administrator the 
applications as it did before the node failed. One way to reproduce the 
preexisting application environment is to perform a recovery for each 
application that was previously installed on the node.

3. Using the cluster Administrator, select Join an existing Cluster and type the 
cluster name.

4. Using the Cluster Administrator on Node_A, ensure that Node_B appears 
available for failover operations.

5. Stop the cluster service in Node_A by using one of the following methods:

• Using the control panel service tool, stop the Cluster service.

• At the command prompt, type the following:

net stop clussvc

6. Select the required items to be recovered for Node_B. The procedure differs 
depending on whether or not the cluster service resides on a domain controller.

If the cluster service resides on a member server and is not a domain controller:

a. Open the NetWorker VSS client software on Node_B.

b. From the left pane, select Recover > System Recover Session

c. Select all local drives except for the NetWorker VSS client installation directory.

d. Select the SYSTEM COMPONENTS folder.

e. From the System Recover Session toolbar, click Start Restore.

If the cluster service resides on a domain controller:

a. Boot the NetWorker VSS client in directory service restore mode as described 
in “Booting Windows in Directory Service Restore mode” on page 65.

b. Open the NetWorker VSS client software.

c. From the Options menu, select System Recover Configuration Options and 
click the NetWorker tab.

d. Unselect the Use Microsoft best practices for selecting the system state 
attribute and click Yes when asked to confirm your selection.

e. Click OK to close the dialog box.
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f. From the left pane, select Recover > System Recover Session.

g. From the Navigation Tree, expand the SYSTEM COMPONENTS folder and 
select BootableSystemState.

h. From the System Recover Session toolbar, click Start Restore.

i. After the Bootable System State is recovered, reboot the NetWorker VSS client.

j. Open the NetWorker VSS client software and select all local drives except for 
the NetWorker VSS client installation directory.

k. Repeat steps c to e to enable the selection of individual components under the 
the SYSTEM COMPONENTS folder.

l. Select all SYSTEM COMPONENTS except for the Bootable System State.

m. From the System Recover Session toolbar, click Start Restore.

When prompted, restart node_B. 

7. Start the Cluster service on node_A by using one of the following methods:

• Using the control panel service tool, Start the Cluster service.

• At the command prompt, type the following:

net start clussvc

8. Using the Cluster Administrator on Node_A, confirm that the cluster resources 
were recovered to the point in time when the backup occurred. If you have been 
performing regular scheduled backups, this will recover the cluster database to a 
point in time shortly before the loss of Node_B.

9. Using the Cluster Administrator on Node_A, monitor the cluster "joining" status 
of Node_B.

10. Using the Cluster Administrator on Node_B, verify that the cluster group can be 
moved between the nodes by right-clicking the group and selecting Move group.

Monitoring a recovery
The progress of all recovery operations can be viewed from the Monitor window. For 
more information about the Monitor window, see “About the NetWorker VSS client 
interface” on page 22.

Booting Windows in Directory Service Restore mode
Before you can complete the following recovery operations, boot the NetWorker VSS 
client in Directory Service Restore mode: 

◆ DFS recovery

◆ FRS recovery

◆ NTDS recovery

◆ Active Directory (AD) disaster recovery

◆ Legacy SYSTEM STATE or VSS SYSTEM BOOT save sets

To boot the NetWorker VSS client in Directory Service Restore mode:

1. On the NetWorker client domain controller, close all programs and restart 
Windows.
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When the computer restarts, a list of startup choices appears. The startup choices 
and the duration of the startup display are based on the settings in the operating 
systems section and the boot loader section of the boot.ini file.

2. Choose the Windows boot option for the domain controller.

3. Press F8 to display a list of special boot options.

4. Select Directory Service Restore Mode (Windows Domain Controllers only) 
from the list of special boot options.

When you boot in this mode, AD is taken offline.

5. Log on as administrator. Use the password that was specified when the domain 
controller was created.

Windows starts in safe mode.

6. Open the NetWorker VSS client application.

7. From the left pane, select Recover > System Recover Session. 

Continue with the recovery options. For more information on:

◆ DFS recovery, see “DFS recovery options” on page 54.

◆ FRS recovery, see “FRS recovery options” on page 55. 

◆ NTDS recovery, see “NTDS recovery options” on page 56.

◆ AD disaster recovery, see “Recovering all Active Directory data from a disaster” 
on page 76.

◆ SYSTEM STATE or VSS SYSTEM BOOT save set recovery, see “Performing a 
recovery” on page 50. If you are recovering these savesets on a domain controller, 
see “Recovering selected Active Directory objects and attributes” on page 74.

Performing an authoritative recovery of NTDS or FRS data
Perform an authoritative recovery only when corrupted or deleted data has been 
propagated to other NT Directory Services (NTDS) or File Replication Services (FRS) 
servers. After the authoritative recovery, the domain administrator can delete any 
unnecessary newer objects.

NTDS and FRS objects may have associated group policies, for example, 
organizational units, domains, and site objects. Group policies are stored in the 
SYSVOL directory. A recovery of the SYSVOL directory cannot be separated from an 
authoritative recovery of NTDS or FRS.

To perform an authoritative recovery:

1. If you have not already done so, boot the NetWorker VSS client in Directory 
Service Restore mode. For more information, see “Booting Windows in Directory 
Service Restore mode” on page 65.

2. If you have not already done so, complete the NTDS or FRS recovery options. For 
more information on:

• FRS recovery, see “FRS recovery options” on page 55. 

• NTDS recovery, see “NTDS recovery options” on page 56.

3. From the command line, use the xcopy command to copy sysvol\domain to 
another location. This preserves group policy, and file and directory permissions.

4. Run the Windows ntdsutil utility. 
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5. At the ntdsutil prompt, type:

NTDSUTIL: authoritative restore

6. To perform an authoritative recovery of the following:

• Entire database, type:

NTDSUTIL: restore database

• Subtree or individual object, type:

NTDSUTIL: restore subtree distinguished_name

For example,

NTDSUTIL: restore subtree 
OU=engineering,DC=Seattle,DC=jupiter,DC=com

NTDSUTIL: restore subtree 
CN=mars,CN=users,DC=Seattle,DC=jupiter,DC=com

For more information, refer to the Microsoft Windows Server Resource Kit 
documentation on Active Directory.

7. Exit the ntdsutil utility by typing quit at each successive ntdsutil prompt until the 
command prompt appears.

8. Copy the entire recovered SYSVOL\domain directory and all of its 
subdirectories to a new location.

9. Restart the domain controller in normal mode.

10. Log in to the domain controller.

11. Wait for the SYSVOL share to be published. 

This can take several minutes while the recovered domain controller 
synchronizes with its replication partners.

12. After the SYSVOL share has been published, perform one of the following:

• For an authoritative recovery of the entire database, copy the entire 
SYSVOL\domain directory tree from the new location (see step 8) to the 
existing SYSVOL\domain directory. When the copy operation prompts for 
confirmation, select Yes to All.

• For an authoritative recovery of only a part of AD that includes Policy objects, 
copy the policy folders from the new location (see step 8) to the existing policy 
folders. Policy objects can be identified by their global universal ID (GUID). 
Policy folders are located in SYSVOL\domain\Policies.

Recovering the Windows system configuration to a pre-NetWorker VSS 
client state

Hosts that were upgraded from a regular NetWorker client to a NetWorker VSS client 
can have their Windows operating system configuration recovered to a state prior to 
upgrading to the NetWorker VSS client. 

CAUTION

If the Windows operating system was upgraded on the host, you cannot recover the 
Windows system configuration to the state it was in before the operating system 
software was upgraded. 
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To recover the Windows system state to a point-in-time that precedes the installation 
of the NetWorker VSS client:

1. If the NetWorker VSS client is a Windows domain controller, boot the NetWorker 
VSS client in Directory Services Restore mode. For more information, see 
“Booting Windows in Directory Service Restore mode” on page 65.

2. Recover the contents of the volume on which the Windows operating system was 
installed.

3. Recover the Windows configuration save sets:

• If VSS was licensed and enabled, recover:

– VSS SYSTEM BOOT
– VSS SYSTEM FILESET
– VSS SYSTEM SERVICES

• If VSS was not licensed or enabled, recover:

– SYSTEM STATE
– SYSTEM FILES
– SYSTEM DB

4. Update the recovered registry with NetWorker VSS client entries.

Because the registry was recovered to a pre-NetWorker VSS client state, you must 
update the registry with entries for the NetWorker VSS client. To update the 
registry, perform the following uninstall / install procedures.

a. Uninstall the NetWorker VSS client software.

b. Install the NetWorker VSS client software.

c. Uninstall the PowerSnap™ software.

PowerSnap is installed with the NetWorker VSS client software.

d. Uninstall the NetWorker VSS client software.

e. Reinstall the NetWorker VSS client software.

For more information about the uninstall / install procedures, refer to the 
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition 
Installation Guide.

f. Reinstall, as necessary, any other applications that were installed after the 
point-in-time to which the Windows operating system configuration was 
recovered.
EMC NetWorker VSS Client for Microsoft Windows Server 2003 First Edition Administration Guide68



4 

This chapter includes the following topics:

◆ Performing a conventional AD or ADAM backup ................................................... 70
◆ Performing an AD or ADAM backup for disaster recovery.................................... 72

Active Directory and
ADAM Backups
Active Directory and ADAM Backups 69



Active Directory and ADAM Backups
Performing a conventional AD or ADAM backup
A conventional Active Directory (AD) backup enables one to recover individual 
objects and object attributes. A conventional ADAM backup enables one to recover 
individual application partitions. 

Unlike other types of NetWorker VSS client backups, a conventional backup does not 
use snapshot technology. Instead, the backup is routed directly to a conventional 
backup medium.

Complete the following tasks before performing a conventional AD or ADAM 
backup.

◆ “Set searchFlags attribute on shared folder and DFS objects” on page 70

◆ “Set up local Windows SYSTEM account as an ADAM administrator” on page 70

Set searchFlags attribute on shared folder and DFS objects
To ensure that shared AD or ADAM folder objects and DFS objects are eligible for 
backup and recovery:

1. Log in to the AD or ADAM server as a Windows administrator.

2. Open the AD or ADAM schema.

3. Locate the property name.

For shared AD or ADAM folder objects, the property name is in the following 
format:

CN=UNC-Name

For DFS objects, the property name is in the following format:

CN=Remote-Server-Name, CN=PKT, and CN=PKT-Guid

4. Right-click the property name and select Properties.

5. Set the searchFlags attribute to 8.

6. Click Apply.

You can now backup and recover DFS objects and shared AD or ADAM folder 
objects.

Set up local Windows SYSTEM account as an ADAM administrator
The ADAM server, which is also a NetWorker client, relies on the NetWorker client’s 
nsrexecd service to spawn the required binaries to perform a backup. The nsrexecd 
service and other binaries run under the Windows SYSTEM account. To ensure that 
these binaries can access ADAM data, the Windows SYSTEM account must be given 
access rights to each instance on the ADAM server.

To set up the Windows SYSTEM account with permissions on the local ADAM server:

1. Open the ADAM ADSI Edit utility.

The ADAM ADSI Edit utility is available with ADAM SP1.

2. Connect to the ADAM instance.

3. In the Connection Settings dialog box, select Well-known naming context and 
select Configuration from the list box.
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4. Type the port number (typically 50000) of the ADAM partition in the Port box and 
click OK. 

5. Select CN=Roles in the left pane

6. In the right pane, right-click on CN=Administrators and then select Properties. 

7. In the CN=Administrators Properties dialog box, select the Member Attribute 
from the attributes list, and then click Edit.

8. Click Add Windows Account and add the local ADAM Server name.

9. Save your changes.

Repeat this procedure for each ADAM instance that you want to back up.

Conventional backup tasks
The tasks involved in setting up a conventional AD or ADAM backup are similar to 
the tasks described in Chapter 2, ”Configuring a Scheduled Backup.” The differences 
are outlined in Table 12. 

Table 12 Setting up a conventional AD or ADAM backup (1 of 2)

Backup task Considerations

Configure a backup pool Use backup pools for conventional AD or ADAM backups that are different 
than the pools used for NetWorker VSS client backups that include snapshots. 
In this way, you can sort conventional AD and ADAM backups from other 
backups.

Configure snapshot policies Do not use a snapshot policy for conventional AD or ADAM backups.

Configure a backup schedule Full and incremental level backups are supported for conventional AD and 
ADAM backups. Level 1 to 9 backups are not supported.

Configure a backup group Do not assign a snapshot policy or a snapshot pool to the backup group.

Configure a Client resource Do not use the same Client resource for AD or ADAM conventional backups 
and other NetWorker VSS client backups including AD or ADAM backups for 
the purposes of disaster recovery.

Configure a Client resource, 
Save Set attribute

Specify domain objects in the following format:
• CN=Users,DC=domain,DC=com
For example:
• CN=Users,DC=corp,DC=xyz,DC=com

where the backup includes Active Directory User objects for the domain 
name, corp.xyz.com.

• CN=user123,CN=Users,DC=domain,DC=com
where the backup includes Active Directory user123 objects for the domain 
name, users.domain.com.
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Performing an AD or ADAM backup for disaster recovery
Performing an AD backup for disaster recovery enables the recovery of the entire AD 
database in the event of a catastrophic loss such as a hardware failure. AD data that is 
protected for a disaster is recoverable on an all or nothing basis. You cannot choose 
individual objects for recovery, instead you must recover the entire AD database in 
one recovery operation. 

To enable the disaster recovery of AD or ADAM data, create a snapshot-based 
scheduled backup as described in Chapter 2, ”Configuring a Scheduled Backup.” 

When specifying save sets for the scheduled backup, follow these recommendations:

◆ For an AD Client resource, specify the save set as:

SYSTEM COMPONENTS:\ .

Note: Microsoft best practices also recommends that a backup AD server be set up so that 
it can be promoted to the primary AD server, in the event of a disaster.

◆ For an ADAM Client resource, specify the save set as:

Applications:\ADAM (instance_name) Writer

Where (instance_name) is the name of the ADAM instance.

Configure a Client resource, 
Backup Command attribute

• AD objects
Type the following command in the Backup Command attribute:
nsradsave.exe
Active Directory domain objects and application partitions on the domain 
host cannot be backed up in the same Client resource. Each type of data 
must be specified on a separate Client resource. For example, to back up 
an Active Directory domain or part of a domain, type the following in one 
Client resource:
nsradsave.exe

• ADAM objects
To back up ADAM application partitions, type the following command in the 
Backup Command attribute:
specify the port number 50000. For example, type the following in another 
Client resource:
nsradsave.exe -p 50000

Configure privileges In addition to the permission set up described in Chapter 2, ensure that the 
steps described in “Set up local Windows SYSTEM account as an ADAM 
administrator” on page 70 are completed.

Configure a proxy client Do not configure a proxy client for conventional AD backups.

Table 12 Setting up a conventional AD or ADAM backup (2 of 2)

Backup task Considerations
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Recovering selected Active Directory objects and attributes
You can individually select deleted Active Directory (AD) objects and their attributes 
for recovery.

Note: Due to AD limitations, there are some restrictions on the recovery of objects and 
attributes. For more information, see “Recovery Restrictions for Active Directory” on page 75.

To recover an AD object or object attribute:

1. Start the NetWorker VSS client User program.

If you are recovering the SYSTEM STATE or VSS SYSTEM BOOT saveset, boot the 
host in Directory Services Restore mode before starting the NetWorker VSS client 
User program. For more information, see “Booting Windows in Directory Service 
Restore mode” on page 65.

2. From the application toolbar, click the NetWorker server icon to select the 
NetWorker server on which the NetWorker client was configured for backup.

3. In the left pane, select Recover > Active Directory Recover Session.

4. In the Navigation Tree, select the AD objects to be recovered. By default, the 
objects displayed in the Navigation Tree are from the most recent backup. 

To recover objects from a previous backup:

• From the application toolbar, click the Browse calendar icon and select an 
earlier browse time. 

• To view all versions of a backup object prior to the selected browse time, select 
an object in the Navigation Tree, right-click and select Versions.

5. To determine whether any volumes need to be mounted for a selected object, 
right-click an object and select Required Volumes.

6. Recover the entire object or selected object attributes.

To recover the entire object:

a. Select the object.

b. From the Active Directory Recover Session toolbar, click Start Recover to 
begin the recovery operation.

To recover just selected attributes of an object:

a. Right-click an object and select Recover this Item.

The Active Directory Recover Attributes dialog box appears.

b. Select each attribute that is to be recovered.

If all attributes or no attributes are selected, the entire object is recovered.

c. Click OK.

7. From the left pane, select Monitor to view the progress of the recovery.
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Recovery Restrictions for Active Directory
The following restrictions apply when recovering Active Directory (AD) objects and 
attributes:

◆ “Tombstone lifetime restriction” on page 75

◆ “System-Only attributes cannot be recovered” on page 75

◆ “Object password attributes” on page 76

◆ “Attributes with null values” on page 76

◆ “Schema objects” on page 76

Note: After starting an AD recovery, access the Monitor view to verify the status of the 
recovery. 

For more information about Active Directory objects and attributes, refer to the 
Microsoft website.

Tombstone lifetime restriction
When an AD object is deleted, it is sent to tombstone. It is better to recover a tombstone 
object instead of re-creating it because data such as the Security Identifier (SID) and 
the Global Unique Identifier (GUID) are stored with the tombstone object. This data is 
critical for additional data recoveries, such as assigned group permissions. For 
example, Access Control Lists (ACLs) use the SID of a security identifier object to 
store its permissions. A re-created group would get a new SID and GUID so that 
permissions assigned to the old group would be lost. Similarly, the SID and GUID are 
both used to recover a user profile. A user's profile would become unusable if a user 
with the same name is re-created. This is because the new profile would be given a 
new SID and GUID.

Objects in tombstone are deleted when they reach the tombstone lifetime age for the 
domain, which is, by default, 180 days. After an object is deleted from the tombstone, 
it cannot be recovered. This is an AD restriction. The tombstone lifetime is a 
configurable attribute of a Windows domain. For more information, refer to the 
Microsoft Windows 2003 Server documentation on AD.

System-Only attributes cannot be recovered
Object attributes that are system-only cannot be backed up nor recovered. This is an 
AD restriction. The following partial list of system-only attributes are not backed up:

◆ distinguishedName

◆ dSCorePropagationData

◆ instanceType

◆ objectCategory

◆ objectClass

◆ objectGUID

◆ uSNChanged

◆ uSNCreated

◆ whenChanged

◆ whenCreated

◆ badPasswordTime
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◆ badPwdCount

◆ lastLogoff

◆ lastLogon

◆ logonCount

◆ sAMAccountType

◆ userAccountControl

Object password attributes
An object’s password is not recovered. After recovering an object with a password 
attribute, the Windows administrator must reset the password.

Attributes with null values
Attributes with null values are not backed up and therefore, are not recovered. For 
example, if an attribute for a phone number was empty (null), then the null Phone 
Number attribute would not be backed up. This is an AD restriction and is intended 
to prevent the unintentional overwriting of valid attribute values. For example, if a 
Phone Number attribute was null when a snapshot was taken but later a valid phone 
number was added, subsequent recovery operations would not overwrite the valid 
phone number with a null value.

Schema objects
Schema objects cannot be recovered and therefore, should never be deleted. 

Recovering all Active Directory data from a disaster
The steps in this procedure assume that any damaged hardware has been replaced 
and that all software has been reinstalled.

To ensure the successful disaster recovery of the Active Directory (AD) server, the 
backup steps described in “Performing an AD or ADAM backup for disaster 
recovery” on page 72 must have been completed.

Note: If you have followed Microsoft best practices, you will have a backup AD server that can 
be promoted to the primary AD server in the event of a disaster. This is the preferred method to 
recover an AD server from disaster. If you do not have a backup AD server that can be 
promoted to the primary AD server, complete the steps in this section to recover from a 
disaster of the AD server.

To recover AD server data from a disaster:

1. If you have not already done so, boot the NetWorker VSS client in Directory 
Service Recovery mode. For more information, see “Booting Windows in 
Directory Service Restore mode” on page 65.

2. Open the NetWorker VSS client software and select the NetWorker server on 
which the NetWorker VSS client was configured for backup. 

3. In the left pane, select Recover > System Recover Session.

4. From the Navigation Tree, open the System Components folder. 

By default, the objects displayed in the Navigation Tree are from the most recent 
backup.
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To recover from a previous backup:

• From the application toolbar, click the Browse calendar icon and select an 
earlier browse time.

• To view all versions of a backup object prior to the selected browse time, 
right-click an object in the Navigation Tree and select Versions.

5. Select items to recover:

If the AD server is not in a clustered environment:

• Select all of the items under the System Components folder.

If the AD server is part of a cluster environment:

a. From the Options menu, select System Recover Session Options and then 
select the NetWorker tab.

b. Unselect the attribute titled Use Microsoft best practices for selecting the 
system state. Click Yes when asked to confirm your selection.

c. Click OK to close the System Recover Session Options dialog box.

d. Select all of the items under the System Components folder except for the 
Cluster Writer.

6. To determine whether any volumes need to be mounted, right-click the selected 
item and select Required Volumes. 

7. From the System Recover Session toolbar, click Start Restore.

8. If you want to perform an authoritative recovery of the AD server, complete the 
steps to perform an authoritative recovery of NTDS or FRS data. For more 
information, see “Performing an authoritative recovery of NTDS or FRS data” on 
page 66.

9. After the AD recovery is complete, reboot the host to restart the AD server.

10. If the AD server is part of a cluster environment, select the Cluster Writer for 
recovery.

11. Recover any remaining volume or application data. For more information, see 
Chapter 3, ”Recovering Data.”
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Roll over a snapshot
A rollover is the process of creating a conventional backup from a snapshot. 
Conventional backups include backup to tape, file type, or advanced file type 
devices. Rollover policies are typically controlled automatically through snapshot 
policy settings on the NetWorker server. For more information, see Chapter 2, 
”Configuring a Scheduled Backup.”

However, you can perform a rollover manually if necessary. For example, before 
recovering a database that currently exists only as a persistent snapshot, consider 
rolling over the snapshot to tape to protect the data in case the snapshot becomes 
corrupted during the recovery process.

Another reason to perform a rollover manually, is to rollover only selected save sets 
from the snapshot. For example, if a snapshot contains two save sets: D:\ and E:\, 
you can select to rollover only the data in the E:\ save set.

To roll over a snapshot:

1. Open the NetWorker VSS client software and select the NetWorker server on 
which the NetWorker client was configured for backup.

2. In the left pane, select Snapshot Management.

3. In the Navigation Tree, select the snapshot and expand the snapshot to view the 
savesets. Select the snapshot or snapshot save sets to be rolled over.

4. From the Snapshot Management toolbar, click Rollover to begin the rollover 
operation.

5. In the left pane, select Monitor to view the progress of the rollover operation.

Roll back a snapshot
A rollback recovery is the process of returning data to an earlier point-in-time. The 
entire contents of a persistent snapshot is recovered during a rollback recovery. You 
cannot select individual components in a rollback recovery operation. A rollback 
recovery is the fastest way to recover the contents of a persistent snapshot.

A rollback recovery is known as a "destructive" recovery because all changes that 
were made after the selected snapshot was taken are overwritten. For example, 
suppose that a snapshot of a database is taken every hour. At 5:30 P.M., it is 
determined that the database is corrupt and that the last known consistent database 
snapshot was taken at 5:00 P.M. When the database host is rolled back to the 5:00 P.M. 
snapshot, all database transactions between the time of the 5:00 P.M. snapshot and 
5:30 P.M. are overwritten.

Rollback recovery requirements
To perform a rollback operation, the following requirements must be met:

◆ The snapshot to be rolled back must reside on a CLARiiON or Symmetrix storage 
system that is supported with the EMC VSS Provider. For more information, refer 
to the EMC NetWorker VSS Client for Windows First Edition Installation Guide.

◆ The NetWorker VSS client to which the snapshot is to be rolled back must be 
supported with a proxy client and the snapshot must have been created using a 
proxy client. For more information about a proxy client, see Chapter 2, 
”Configuring a Scheduled Backup.”
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◆ The nested mount points on file systems are dismounted prior to performing the 
rollback restore.

◆ The Microsoft Exchange checkbox titled This database can be overwritten by a 
restore is selected for each Exchange database that is to be recovered. This 
checkbox can be found by using the Exchange SYSTEM Manager application.

◆ The databases are detached for each Microsoft SQL Server database that is to be 
recovered.

◆ A storage array descriptor file is created and placed in the nsr\res directory on 
the NetWorker VSS client host. This file contains information about the storage 
arrays connected to the proxy client data mover.

To create a storage array descriptor file:

1. Using a text editor, create a file and name it sa.ini.

2. In the sa.ini file, add a heading for storage arrays and specify the total number of 
storage arrays connected to the proxy client. For example, if there are two storage 
arrays, type the following value:

[Storage_Array]
Storage_Array_Count=2

3. For each storage array, specify the storage array ID. For example, entries for two 
storage array IDs might look like the following:

Storage_Array_1=APM00052106710
Storage_Array_2=APM00052211461

4. Add a heading for each storage array ID and specify information about the 
storage array. For example, a CLARiiON storage array ID entry might look like 
the following:

[APM00052106710]
Array_Type=CLARiiON
Array_model=CX500
Array_user=user_name
Array_pass=password
Array_SPA=IP_Address_of_Storage_Processor_A
Array_SPB=IP_Address_of_Storage_Processor_B

5. Save the sa.ini text file and place it in the <NetWorker_install_path>\nsr\res 
directory on the NetWorker VSS client host.
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Sample CLARiiON sa.ini file
A sample sa.ini file for two CLARiiON storage arrays would look similar to the 
following:

[Storage_Array]
Storage_Array_Count=2
Storage_Array_1=APM00052106710
Storage_Array_2=APM00052211461

[APM00052106710]
Array_Type=CLARiiON
Array_model=CX500
Array_user=sbarma
Array_pass=7dn2dG9A
Array_SPA=122.222.111.128 
Array_SPB=122.222.111.129

[APM00052211461]
Array_Type=CLARiiON
Array_model=CX300
Array_user=jdinge
Array_pass=sl6GH792
Array_SPA=122.222.110.121
Array_SPB=122.222.110.122

Sample Symmetrix sa.ini file
A sample sa.ini file for a single Symmetrix storage array would look similar to the 
following:

[Storage_Array]
Storage_Array_Count=1
Storage_Array_1=000187461273

[000187461273]
Array_type=Symmetrix
Array_sid=197
Array_Model=DMX-800

Performing a rollback recovery
Before performing a rollback recovery, ensure that the rollback requirements have 
been met. For more information, see “Rollback recovery requirements” on page 80.

To perform a rollback recovery:

1. Open the NetWorker VSS client and select the NetWorker server on which the 
NetWorker client was configured for backup. 

2. In the left pane, select Snapshot Management.

3. If you are performing a rollback for EMC Symmetrix configurations that use 
RAID5 Business Continuance Volumes (BCVs), perform the following steps:

a. Delete all snapshots for the Standard EMC Disk (STD), except for the snapshot 
to be rolled back. For information about deleting snapshots, see “Delete a 
snapshot” on page 83.
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The deletion operation will put the snapshot BCVs in the established state. 
Once you have completed the deletions, there should be only one snapshot 
BCV in the split state, and that this is the snapshot BCV that is to be rolled 
back. 

Note: To prevent the loss of data from a snapshot that is to be deleted, perform a 
rollover of the snapshot before the deletion operation. For information about rolling 
over a snapshot, see “Roll over a snapshot” on page 80.

b. Use the SYMCLI commands to disassociate the BCVs and Virtual Devices 
(VDEVs) that are in the established state. 

c. If the snapshot used multiple STDs, perform the previous steps for each STD. 

4. In the Navigation Tree, select the snapshot to be rolled back.

5. Right-click the selected snapshot and select Rollback.

6. In the left pane, select Monitor to view the progress of the rollback operation.

7. When rollback processing has completed, reboot the host to complete the rollback 
operation.

8. If you performed a rollback on an Exchange or SQL database, remount the 
database. If you performed a rollback on a file system that had nested mount 
points, remount the nested mount points.

Delete a snapshot
Snapshot deletion policies are typically controlled automatically through snapshot 
policy settings on the NetWorker server. For more information, see Chapter 2, 
”Configuring a Scheduled Backup.” 

However, you can delete a snapshot manually. For instance, if space must be made 
available immediately on the storage system, you can manually roll over and then 
delete snapshots.

CAUTION

If a snapshot is deleted without the use of the NetWorker VSS Client user 
interface, the snapshot may still appear to be recoverable in the NetWorker VSS 
client user interface. If such a snapshot is selected for recovery, the recover 
operation will fail. A snapshot could by a user in another application. A snapshot 
could also be deleted by VSS or the storage subsystem if resources are exhausted 
due to high input/output rates on the volumes.

To delete a snapshot:

1. Open the NetWorker VSS client software and select the NetWorker server on 
which the NetWorker client was configured for backup. For more information, 
see “Opening the software and connecting to a NetWorker server” on page 25.

2. In the left pane, select Snapshot Management.

3. In the Navigation Tree, select the snapshot to be deleted.

4. Right-click the selected snapshot and select Delete.

5. In the left pane, select Monitor to view the progress of the delete operation.
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Specifying ranges for service and connection ports
A service port is a listener port that provides services to NetWorker VSS client hosts. 
The default range for service ports is 7937 to 9936. A connection port is used to 
contact a service, whether it is on a NetWorker server, storage node, or client. The 
default range for connection ports is 10001-30000. 

To implement an enhanced security environment, it may be necessary to reduce the 
range of available ports. For more information about determining the size of the port 
range, refer to the EMC NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide or 
later.

To reduce the range of available ports:

1. From the Options menu, select Configure Options.

The Configure Options dialog box is displayed.

2. In the Service Ports attribute, enter the range of available ports.

3. In the Connection Ports attribute, enter the range of available ports.

4. Click OK.

Note: If a firewall exists between the NetWorker client and any NetWorker servers, ensure that 
the firewall is configured to accept the port ranges entered in the Configure Options dialog 
box.

Specifying a password
The password is used to protect items that will be backed up with either PW1 
password-protection or PW2 encryption and password-protection. PW1 and PW2 
protection is enabled on the NetWorker server with a local or global directive. For 
more information about PW1 and PW2 protection, refer to the EMC NetWorker, Release 
7.3.2, Multiplatform Version, Administration Guide or later.

CAUTION

Changing the password does not change the password for files that have already 
been backed up. To recover PW1 or PW2 password-protected files, you must 
provide the password that was in effect at the time of the backup.

To change the PW1 password:

1. From the Options menu, select Configure Options.

The Configure Options dialog box is displayed.

2. In the Old password attribute, type the password that is currently in effect.

3. In the New password attribute, type the new password.

4. In the Confirm password attribute, retype the password.

5. Click OK. 

The new password will be applied to future scheduled backups for the NetWorker 
VSS client where password-protection has been enabled with a global or local 
directive.
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The troubleshooting process
NetWorker and the NetWorker VSS Client for Microsoft Windows provide many 
resources to help discover and isolate problems. Setting up these resources before 
problems occur can help if and when troubleshooting problems occur later. 

If the problem is not with the NetWorker VSS client, there are other NetWorker 
resources and documentation that may provide a solution.

The following flowchart, Figure 10, “Troubleshooting process,” provides an overview 
of the process and sections of this chapter for troubleshooting a scheduled backup or 
recovery problem. 
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Figure 10 Troubleshooting process
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Setting up notifications 
Set up NetWorker software and NetWorker VSS client software to send notifications 
about events. These notifications can be sent to several locations, including log files, 
SNMP printers, SNMP management console, and email messages. The EMC 
NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide describes how to 
set up notifications.

Finding errors
When a problem occurs, a notification or message might be displayed, or appear in a 
log file. Table 13 on page 90 describes several ways that NetWorker server, 
NetWorker VSS client, and other NetWorker features provide information about 
problems. 

NetWorker VSS client error messages
Error messages help to identify which product is having a problem. The following 
sections describe error messages that are specific to the NetWorker VSS client. 

E_VOLUME_NOT_SUPPORTED
This error occurs when CLARiiON is down, an array is unmanaged, or the 
CLARiiON disk is not visible. This error also occurs when Data Mover is used to take 
a local volume replica. The error message will appear in NetWorker VSS client and 
Replication Manager logs.

Solution
Check in the CLARiiON array for storage allocation. 

Table 13 Notifications and errors

Type Description

Email notification of a 
NetWorker event

A NetWorker client can be set up to send an email notification about NetWorker 
events. 

Error message windows Appear on the NetWorker server when an error occurs during backup or recovery 
operations. 

NetWorker Monitor window Displays details of current NetWorker server activities, operations related to devices 
and libraries, and events that require user intervention.

Event viewer Alerts users that user intervention is required on the NetWorker server.

Log files Log files are created for each operation and process. Separate log files are 
available for NetWorker and various features, depending on what features are 
installed and in use:
• NetWorker VSS Client for Microsoft Windows
• NetWorker 
• NetWorker PowerSnap™
• Replication Manager
• Solutions Enabler
• EMC VSS Provider
The logging level of the log file is controlled by the debug level of the process. 
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E_VETO_PROVIDER 
There are several possible causes for this error:

◆ Storage resources such as Symmetrix clones or CLARiiON BCVs have been added 
but the Replication Manager service was not recycled to rebuild the storage 
resource cache. The provider finds the LUN as hosted by the storage array, but 
fails to find storage resources in the storage resource cache.

◆ There is a load on the CLARiiON array, and replica creation fails.

◆ A CLARiiON snapshot is performed when there are not enough LUNs in the 
reserved LUN pool. In this case, the rmsnap command fails. 

◆ A CLARiiON snapshot is performed, but the number of established snapshot 
sessions to the LUN has already reached the limit.

Solution
Use the net stop and net start commands to stop and restart the EMC VSS provider, 
Microsoft VSS services, and Replication Manager services. 

For example, to stop and restart the Replication Manager service:

1. From the command line, stop the rmagentps service. 

net stop rmagentps

2. Start the rmagentps service. 

net start rmagentps

VSS_E_WRITERERROR_RETRYABLE error code 0x800423f3
This error occurs if a savegroup is rerun, and it was stopped previously while a 
replica was being taken and the replica did not complete.

Solution
Stop EMC VSS provider, Microsoft VSS services, and Replication Manager services. 
Then start those services. Also restart Exchange Information store if it was running 
and was backed up.

VSS CLIENT... Invalid Writer Selection ... for APPLICATIONS
This error might occur if Microsoft Exchange services are not up or if SQL databases 
are offline.

Another cause of this error is if there is a typographical error in writing 
Applications:\Microsoft Exchange Writer.

Solution
For Microsoft Exchange applications, start the Exchange services. If Exchange 
services were already up, dismount and mount the databases and then start the 
savegroup.

For SQL Server applications, bring the databases online.

Solution
Retype the words correctly or use the nsrsnap_vss_save -? command, as described in 
“Displaying valid application data save sets” on page 41, to display a listing of all 
valid application save sets on the NetWorker VSS client. 
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NetWorker VSS client issues
The following section describes some common problems and possible solutions for 
NetWorker VSS client. Check this section first when there appears to be a problem but 
there is no specific error message in monitoring or event logs. 

Savegroup failed in scheduled backup
A notification appears in the NetWorker Monitor window that a savegroup failed. 

Solution
Check the savegroup details for the failed save set. This may provide an exact cause, 
or a general error, which should indicate whether it is a client-side or server-side 
issue. The EMC NetWorker, Release 7.3.x, Multiplatform Version, Administration Guide 
provides information about viewing group backup details. 

If there is not enough information in the savegroup details, check the NetWorker VSS 
client log and other client-side logs.

“Checking log files” on page 96 provides more information about the log names, 
locations, and details.

In progress backup fails
If a node within a cluster undergoes failover during a backup operation, the 
operation will not be successful. The next scheduled backup operation will be the 
next valid backup.

Solution
If you are using a hardware provider such as the EMC VSS Provider, use the disk 
management utilities provided with the associated hardware to delete any resources 
that may be left in an indeterminate state as a result of the failed backup. For 
example, a CLARiiON storage solution may have an inactive snapshot as the result of 
a failed backup. In this case, use the EMC NaviCLI interface to search for and delete 
the inactive snapshot.

NetWorker is blocked by Windows Firewall
After installing Microsoft Windows Server 2003 (SP1), The Windows Firewall may be 
blocking NetWorker processes from sending information through the firewall.

Solution
The EMC NetWorker VSS Client for Windows Server 2003 First Edition Installation Guide 
provides information about how to extend the Security Configuration Wizard or 
manually configure Windows Firewall exceptions. 

Need to run utility to obtain Exchange Server information 
The utility nwexinfo.exe runs when NetWorker VSS client is installed on an 
Exchange Server. This utility gathers the Exchange username, password, and domain, 
and then inserts this information in the registry. 
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Solution
Rerun the utility if any of the following conditions occurs:

◆ Exchange Server is installed after NetWorker VSS client is installed.

◆ The Exchange username, password, or domain values change after the 
NetWorker VSS client is installed. 

To run the utility:

1. Navigate to the following folder:

<NetWorker_install_path>\nsr\bin

2. Run nwexinfo.exe.

3. Change the Exchange password, username, and domain as required.

Requesting a snapshot for a volume on hardware that is 
not transportable

When volumes are added to the NetWorker VSS client snapshot set, an error might 
appear if a transportable hardware snapshot is requested and the volume that is 
being replicated is not a volume that resides on special hardware that is 
transportable. The following error message might also appear:

VSS_E_VOLUME_NOT_SUPPORTED_BY_PROVIDER.

Solution
The Exchange server and Proxy server (if one is set up for Exchange) must have 
matching volumes or alternate mount path in PowerSnap (PS) attribute. An Exchange 
backup that is mounted on a Proxy server needs either matching volumes or an 
alternate location to mount Exchange databases and logs. 

An example of matching volumes would be D: to D: and E: to E:.

An example of alternate location would be "G:\altpath" on the Proxy server. In this 
example, the snapshot of "D:\" would be mounted on the Proxy server as 
"G:\altpath\D\" and the snapshot of "E:\" would be mounted on the Proxy server as 
"G:\altpath\E\." 

To use the alternate mount path, set the PowerSnap attribute NSR_ALT_PATH in the 
Client resource. In the preceding example of an alternate location, the attribute would 
be set to "NSR_ALT_PATH=G:\altpath." “Task 5: Configure a Client resource” on 
page 38 provides more information about creating a Client resource. 

PowerSnap service must be restarted after the NetWorker service
is restarted

After restarting the NetWorker service, if the PowerSnap service is not restarted, the 
first retention or rollover will fail. The following message appears:

RPC send operation failed. A network connection could not be 
established with the host. 

The PowerSnap service will re-establish the connection on the next operation, so this 
failure will only occur once.

Solution
To fix this problem, restart the PowerSnap service after restarting the NetWorker 
service, before running a PowerSnap operation. 
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PowerSnap validation for recovery fails
When the service is not stopped, recovery fails while validating PowerSnap for 
recovery. Some VSS writers require that the service be stopped while recovering. For 
example, the SQL writer requires that the service be stopped while recovering the 
SQL database. 

Solution
To fix this problem, stop the service before recovering. 

Snapshot backup may fail with writer errors 
A snapshot backup may fail with VSS writer errors that indicate the writer may be in 
an unstable state, such as the following: 

VSS_E_WRITERERROR_NONRETRYABLE

VSS_E_BADSTATE

VSS_E_UNEXPECTED_WRITER_ERROR

Solution
Contact EMC Technical Support.

Microsoft I/O write error when taking a replica in a CLARiiON array
This problem might occur when a replica is taken in a CLARiiON array LUN backup.

Solution
To fix this problem, stop the EMC VSS provider, Volume Shadow Copy Service and 
Replication Manager services. Then start those services. 

Creating a replica takes a long time in CLARiiON environment
Older version of FLARE® OS running on CLARiiON may take a long time to create a 
replica.

Solution
To fix this problem, update CLARiiON FLARE OS to the latest version.

Cannot recover Exchange database due to overwrite prevention error
If an Exchange database has not been selected for recovery in the Exchange System 
Manager, recovery for that database will fail. When a recovery attempt fails, several 
entries are displayed in the NetWorker Monitor window. For example:

"VSS CLIENT... Database "Mailbox Store 2 (SERVERX)" in Storage Group 
"Second Storage Group" does not have the "This database can be 
overwritten by a restore." checkbox marked."

"VSS validatation and preprocessing failed for Microsoft Exchange 
Writer."

"nsrsnap_vss_recover: Recovery operation failed. Refer to log file(s) 
for details."
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The following message may be displayed by Microsoft Exchange:

The database files in this store were replaced with older versions by 
an offline restore. To use the restored files, open the database 
property page for this store, select "this database can be 
overwritten by a restore", wait for active directory replication, 
and try again.

Error ID: C104173A 
Exchange System Manager 

Solution
Search for "KB293324"on the Microsoft Help and Support website, and go to the 
article "XADM: "C104173A" Error Message Occurs After You Restore the Database." 
Follow the instructions for changing the setting in Exchange System Manager. 

Incremental backups within NetWorker Module for Exchange
Client may be promoted to full backups

If the NetWorker VSS User Client is installed, requests for an incremental backup 
through the NetWorker Module for Exchange Client are automatically promoted to a 
full backup. This does not affect NetWorker VSS User Client incremental backups of 
volumes. 

For example, suppose that NetWorker Module for Exchange Client requests an 
incremental backup for Exchange server "EXSRV1." If NetWorker VSS User Client is 
installed, then the NetWorker Module for Exchange Client promotes its own 
incremental backup to a full backup to maintain the integrity of the backup and 
prevent data loss. However, the NetWorker VSS User Client can still perform an 
incremental backup of a volume, such as "D:\" on "EXSRV1."

Incremental backups within NetWorker Module for SQL Server
Client may be promoted to full backups

If the NetWorker VSS User Client is active and configured to back up the SQL 
database, requests for an incremental backup through the NetWorker Module for 
SQL Client are automatically promoted to a full backup to maintain the integrity of 
the backup and prevent data loss. Installation of the NetWorker VSS User Client itself 
does not automatically promote NetWorker Module for SQL Client incremental 
backups to full backups. This does not affect NetWorker VSS User Client incremental 
backups of volumes. 

For example, suppose that the NetWorker Module for SQL Client requests an 
incremental backup for SQL server "SQLSRV1." If the NetWorker VSS User Client is 
installed, and the NetWorker VSS User Client performs backups of the SQL database, 
then the NetWorker Module for SQL Client automatically promotes the incremental 
backup to a full backup. 

However, if the NetWorker VSS User Client is installed but does not perform backups 
of the SQL database, then a request through the NetWorker Module for SQL Client 
for an incremental backup is allowed. In either case, the NetWorker VSS User Client 
can still perform an incremental backup of a volume, such as "D:\" on "SQLSRV1."
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Checking log files
There are many log files generated by NetWorker VSS client and associated features. 
These log files include errors that occur during the processes. Check the log files in 
the following order: 

1. “NetWorker VSS client” on page 96

2. “PowerSnap client” on page 96

3. “Replication Manager” on page 97 

4. “Solutions Enabler” on page 97

5. “Active Directory” on page 97

6. “NetWorker Server” on page 98

In addition, third party providers generate their own logs in place of the Solutions 
Enabler log (hwprov.log). For more information, check the third party 
documentation. 

NetWorker VSS client

Log file
◆ vssclient.log

Location
Applogs folder. For example, C:\Program Files\Legato\nsr\applogs\.

Description
Both save and recover CLIs write to this file. The log file is cumulative, so it is 
appended with each run. The logging level of the log file is controlled by the debug 
level of the process (-D).

PowerSnap client 

Log files
NetWorker VSS Client Interface Library: 

◆ libvsspsclnt.XXXXX.log

PowerSnap Client Core Processes. There are log files for each process that runs:

◆ nsrbragent.XXXXX.log

◆ nsrsnapagent.log

◆ nsrsnapbwragent.log

◆ nsrsnapck.log

Location
Logs folder. For example, C:\Program Files\Legato\nsr\logs\.

Description
Usually the PowerSnap Client creates one set of log files for each backup or recover 
session, and a debug and trace log are created. These log files are tied together by 
using the Snapshot Session ID. 
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The logging level of the log files is controlled by setting a variable in 
NSR_PS_DEBUG_LEVEL in NetWorker Server, in client configuration. 

Error messages in PowerSnap Client log files also appear in the standard user 
interface outputs for NetWorker VSS client.

Replication Manager

Log files
◆ erm_clientXXXXX_debug.log

◆ erm_clientXXXXX_detail.log

◆ erm_clientXXXXX_summary.log

Location
Replication Manager Agent Service log files are in the logs\client folder of the RM 
installation. For example, C:\Program Files\EMC\rmagentps\logs\client\ 

Description
The log files are cumulative, and will wrap once they reach a certain length.

The debug level can be set through the registry key 
HKLM\SOFTWARE\RMSERVICE\RMAgentPS\Client\4.0.0\CC_DEBUG_LEVEL. 
The default value is 2, but can be changed to 3. To change the value, stop RM Services, 
change the value in the registry, and then restart RM Services. 

Error messages in Replication Manager log files also appear in the standard user 
interface outputs for NetWorker VSS client.

Solutions Enabler

Log files
The log files include a log file for the EMC VSS Provider and SYMAPI

◆ hwprov.log

◆ symapi-<date>.log

Location
The Solutions Enabler product creates log files in the SYMAPI\logs folder of the 
Solutions Enabler installation. For example, C:\Program Files\EMC\SYMAPI\log\

Description
The log files are cumulative, or based on the date. The logging level of the EMC VSS 
Provider log file is controlled by a registry key.

Error messages in Solutions Enabler log files do not appear in the standard user 
interface outputs for NetWorker VSS client

Active Directory

Log files
◆ nsradsave.log

◆ nsradrecover.log

Location
Applogs folder. For example, C:\Program Files\Legato\nsr\applogs\
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NetWorker Server

Log files
The NetWorker server creates several log files, which are documented in the EMC 
NetWorker, Release 7.3.x, Multiplatform Version, Administration Guide.

Manually stopping and starting services
NetWorker VSS Client processes may need to be manually stopped and started in 
conjunction with configuration and troubleshooting activities. The EMC NetWorker, 
Release 7.3.x, Multiplatform Version, Administration Guide provides more information 
about starting and stopping services on Windows and UNIX hosts, Console server, 
NetWorker Server, Client, or Storage Node. 

Table 14 on page 98 lists the services for NetWorker, PowerSnap, and Replication 
Manager that are active on the system. 

Table 14 Services used in NetWorker VSS Client (1 of 2)

Executable Product Category Function

Nsrexecd NetWorker Service Authenticates and processes the NetWorker server’s remote 
execution requests and executes the save programs on the 
client.

Nsrpsd PowerSnap Service Provides PowerSnap Client services, including snapshot 
consistency check function, to apply retention policy and backup 
functions to rollover snapshots.

Irccd.exe Replication 
Manager

Service Provides Replication Manager Client application and storage 
services for creating VSS-based snapshots and for rollback of 
VSS-based snapshots for EMC storage.

RMServer.exe Replication 
Manager

Service Provides Replication Manager Server services for executing 
workflow for creating VSS-based snapshots.

Rm_api.dll Replication 
Manager

Library Library that provides Replication Manager Client interface library 
for NetWorker, used by NetWorker backup and recover 
processes.

Nsrsnap PowerSnap Process Temporary process active during snapshot groups that provides 
client-side workflow for snapshot groups, including applying 
retention policy, spawning process to create the snapshot, and 
spawning process to rollover the snapshot.

Nsrsnap_vss_save NetWorker Process Temporary process active during snapshot groups that is 
responsible for executing the client-side workflow to create the 
snapshot for the savesets specified in the client resource. It is 
spawned by ‘nsrsnap’ and will communicate with irccd.exe to 
create the VSS-based snapshot, and then will communicate with 
PowerSnap services to register the snapshot.

Libpsvssclnt.dll PowerSnap Library Library that provides PowerSnap Client Interface for NetWorker 
backup and recover processes.
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Other troubleshooting resources
Does the problem appear to be on the NetWorker server or on a NetWorker client?

If it appears on the NetWorker server, or otherwise seems to be on the server side, 
check to make sure that the NetWorker server is installed and configured correctly. 
Also, check the log files and error message documentation for the NetWorker server. 

If the problem appears to be with PowerSnap or Replication Manager, and is not 
unique to NetWorker VSS Client for Microsoft Windows, check other documentation. 
The following documents provide specific error message, troubleshooting, or other 
documentation outside of NetWorker VSS Client for Microsoft Windows:

◆ EMC NetWorker Release 7.3.2 Multiplatform Version Installation Guide 

◆ EMC NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide

◆ EMC NetWorker Release 7.3 Multiplatform Version Error Message Guide

◆ PowerSnap Module Installation and Administration Guide

◆ Replication Manager Administration Guide

Nsrsnapagent Temporary 
Service

Temporary service active during snapshot backup and restore 
operations that provides snapshot management functions to 
import and assign drive letters to a snapshot.

Nsrsnapbwragent Temporary 
Service

Temporary service active during snapshot backup and file 
system snapshot browse operations that provides the ability to 
read the file system on the snapshot.

Winworkr NetWorker Process Provides graphical user interface for NetWorker. 

Table 14 Services used in NetWorker VSS Client (2 of 2)

Executable Product Category Function
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Glossary

This glossary contains terms related to disk storage subsystems. Many of these terms 
are used in this manual.

A
ad hoc backup A backup that a user requests from the client. The user specifies the files, file systems, 

and directories to backup. An ad hoc backup is also known as a manual backup.

Administrators group A Microsoft Windows user group whose members have the rights and privileges of 
users in other groups, plus the ability to create and manage the users and groups in 
the domain. 

Application Specific
Module (ASM)

A program that is used in a directive to specify how a set of files or directories is to be 
backed up or recovered. For example, compressasm is a NetWorker directive used to 
compress files.

archive Backing up directories or files to an archive volume to free disk space. Archived data 
is not recyclable. 

archive volume A volume used to store archive data. You cannot store archive data on a backup 
volume or a clone volume.

ASM See Application Specific Module (ASM).

auto media
management

A feature that enables the storage device to automatically label, mount, and overwrite 
an unlabeled or recyclable volume.

autochanger See library.

autochanger sharing See library sharing.

B
backup An operation that saves data to a volume.

See also conventional backup and snapshot.

backup components
metadata document

See metadata document.

backup group See group.
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backup level See level.

backup volume A volume used to store backup data. You cannot store backup data on an archive 
volume or a clone volume.

bootstrap A save set that is essential for NetWorker disaster recovery. A bootstrap is composed 
of two components that reside on the NetWorker server: the media database, and the 
resource database. The bootstrap also provides information that is essential to recover 
a client file index.

browse policy A policy that determines how long backed up data is available for quick access. See 
also retention policy.

C
carousel See autochanger.

client A host, workstation, or fileserver whose data can be backed up or recovered. See also 
Client resource.

client file index A database that tracks every database object, file, or file system that is backed up. The 
NetWorker server maintains a single client index file for each client. 

client-initiated
backup

See ad hoc backup.

Client resource A NetWorker server resource that identifies the save sets to be backed up on a client. 
The Client resource also specifies information about the backup, such as the schedule, 
browse policy, and retention policy for the save sets. Multiple Client resources can be 
configured for one client host. For example, you could create one Client resource to 
back up business data and another to back up operating system files. See also client 
and resource.

clone A reliable copy of backed up data. Unlike volumes created with a simple copy 
command, clone volumes can be used in exactly the same way as the original backup 
volume. Single save sets or entire volumes can be cloned.

clone volume A volume used to store clone data. You cannot store clone data on an archive volume 
or a backup volume.

cluster Two or more nodes that are connected and appear to network users as a single, highly 
available system. 

command prompt A window in which you type commands.

component 1. A group of related data that must be treated as a single unit for backup and 
recovery. 

2. In Microsoft VSS terminology, a component is a subordinate unit of a writer.

components
metadata document

See metadata document.

consistency The application view of a set of data is in a state that is consistent with the 
application’s usage of the data at any point-in-time when the application is active.
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Console server NetWorker servers and clients are managed from the NetWorker Console server. The 
Console server also provides reporting and monitoring capabilities for all NetWorker 
servers and clients. 

conventional backup A NetWorker backup to a conventional backup device such as a tape library.

Compare to snapshot.

D
data mover The NetWorker client that processes and backs up a snapshot. This may be the client 

whose data is the source of the snapshot, or it may be a different client, which is 
known as a proxy client. See also proxy client.

data retention policy See retention policy.

datawheel See autochanger.

datazone A group of hosts administered by a NetWorker server.

DDS See Dynamic Drive Sharing (DDS).

device 1. A storage unit that reads from and writes to backup volumes. A storage unit can be 
a tape device, optical drive, autochanger, or file connected to the server or storage 
node.

2. When dynamic drive sharing (DDS) is enabled, refers to the access path to the 
physical drive.

DFS See Distributed File System (DFS).

directed recovery A recovery method used to recover data that originated on one NetWorker client host 
to another NetWorker client host.

directive Instructions to take special actions on a given set of files for a specified client during a 
backup or recover operation.

disk subsystem An integrated collection of storage controllers and/or HBAs, disks, and any required 
control software that provides storage services to one or more hosts, such as 
CLARiiON arrays.

Distributed File System
(DFS)

A Microsoft Windows add-on that allows you to create a logical directory of shared 
directories that span multiple machines across a network.

domain controller A host that manages user interactions with a domain, including logon, 
authentication, directory searches, and access to other shared resources.

Dynamic Drive
Sharing (DDS)

A feature that allows NetWorker software to recognize shared drives.
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F
file index See client file index.

file system 1. A file tree located on a specific disk partition or other mount point.

2. The entire set of all files.

3. A method of storing files.

full backup See level.

G
group A NetWorker server resource that specifies the scheduled backup time for a client or 

group of clients.

H
highly available

system
A system that allows cluster-aware services to continue despite a hardware or 
software failure.

host ID A serial number that uniquely identifies a host computer.

I
inactivity timeout The number of minutes to wait before a client is considered to be unavailable for 

backup.

incremental See level.

instant backup The process of creating a persistent snapshot (point-in-time copy) of a group of files, 
volume, or filesystem from a single client to a storage disk volume that can be 
recovered (used as a backup copy). The instant backup may or may not be written to 
tape.

instant recovery The process of copying back the saved group of files or a filesystem from a mounted 
storage disk volume of a single client, which was created using instant backup.

General term for capabilities that enable near-instant access to production data in the 
event of data corruption to a production database. Includes both mounting replicas to 
an alternate host for recovery purposes and restoring the replicas to the production 
host.

J
jukebox See autochanger.

L
label A NetWorker assigned label that uniquely identifies a volume. Templates can be used 

to define label parameters.

legacy backup
method

The use of special case Microsoft APIs that are required for backup and recovery of 
operating system components, services, and specific applications.
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level A measurement that determines how much data is saved during a scheduled or ad 
hoc backup. 

library A mechanism that uses a robotic arm to move media among various components in a 
device. The term library is synonymous with autochanger, autoloader, carousel, 
datawheel, jukebox, and near-line storage.

library sharing Shared access of servers and storage nodes to the tape drives in a library.

local cluster client A NetWorker client that is not bound to a physical machine, but is instead managed 
by a cluster manager. It is also referred to as a logical or virtual client.

locale settings Settings that specify the input and output formats for date and time, based on local 
language conventions.

LUN address The SCSI identifier of a logical unit number (LUN) within a device target. Each LUN 
address identifies a device on a SCSI bus that can perform input/output (I/O) 
operations.

M
manual backup See ad hoc backup.

media The physical storage medium, such as magnetic tape, optical disk, or file system to 
which backup data is written.

media database Indexed entries about the location and the life cycle status of all data and volumes 
that the NetWorker server manages. See also volume.

media index See media database.

metadata document VSS Information stored in an XML document that is passed from the writer to the 
requestor. Metadata includes the writer name, files and components to back up, a list 
of components to exclude from the backup, and the methods to use for recovery. See 
also shadow copy set.

mount To make a volume physically available so that backup data can be written to it.

mount point See volume mount point.

N
NDMP See Network Data Management Protocol (NDMP).

Network Data
Management

Protocol (NDMP)

A TCP/IP-based protocol that specifies how heterogeneous network components 
communicate for the purposes of backup and recovery.

NetWorker
administrator

A user who can add to or change the configuration of the NetWorker server, media 
devices, and libraries. NetWorker administrators must have their usernames 
included in the NetWorker server Administrator list. 

NetWorker client See client.

NetWorker Console
server

See Console server.
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NetWorker
Management

Console

See Console server.

NetWorker server The host running the NetWorker server software, which contains the online indexes 
and provides backup and recovery services to the clients on the same network.

NetWorker storage
node

See storage node.

nonclone pool Pools that contain data that has not been cloned.

nonpersistent
snapshot

A snapshot that is rolled over to tape and then deleted from disk is said to be 
nonpersistent.

O
online indexes Databases on the NetWorker server that contain information about client backups 

(client file index) and backup volumes (media database).

operator The person who monitors the server status, loads backup volumes into storage 
devices, and executes day-to-day NetWorker tasks.

P
pathname Instructions for accessing a file. An absolute pathname indicates how to find a file 

starting from the root directory. A relative pathname indicates how to find the file 
starting from the current directory.

persistent snapshot A snapshot that is retained on disk. A persistent snapshot may or may not be rolled 
over to tape.

PIT Point-in-time.

point-in-time copy A fully usable copy of a defined collection of data, such as a consistent filesystem, 
database, or volume, which contains an image of the data as it appeared at a single 
point in time. A PIT copy is also called a shadow copy or a snapshot.

policy A set of constraints that specify how long data is available for recovery. Each Client 
resource has a browse policy and a retention policy.

pool A feature to sort backup data to selected volumes.

PowerSnap EMC technology that provides point-in-time snapshots of data. NetWorker software 
backs up data from the snapshot. This allows applications to continue to write data 
during the backup operation, and ensures that open files are not omitted.

provider A software component defined by Microsoft VSS, that plugs into the VSS 
environment. A provider, usually produced by a hardware vendor, enables a storage 
device to create and manage snapshots.

proxy client A host that acts as a remote data mover during snapshot operations. A proxy client 
performs the NetWorker save operation for the NetWorker VSS client that requested 
the backup. A proxy client is required to perform a serverless backup.
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Q
quiescing Stopping all writes to disk and flushing the filesystem cache. Quiescing the database 

prior to creating the snapshot provides a transactionally consistent image that can be 
remounted without filesystem checks or database consistency checks. Quiescing a 
database is the most common way of creating a database snapshot. 

R
recover To recover files from a backup volume to a client disk.

Registry A Microsoft Windows database that centralizes all Windows settings and provides 
security and control over system, security, and user account settings.

requestor Interfaces with the Microsoft VSS infrastructure to initiate the creation and 
destruction of shadow copy. NetWorker software is a requestor.

replica See shadow copy.

resource A component that describes the NetWorker server or its clients. Clients, devices, 
schedules, groups, and policies are all NetWorker resources. Each resource has 
attributes that define its properties.

retention policy Determines how long backup data is available for recovery, though not necessarily 
immediate recovery. See also browse policy.

retrieve To locate and recover archived files and directories.

rollback The process of returning data to an earlier snapshot in response to a recovery 
operation. A rollback is a complete recovery of a storage subsystem from a 
point-in-time copy to a standard volume without host involvement. 

Because no host process is involved in copying data and data does not get retrieved 
from tape to disk, this type of recovery is faster in comparison to traditional recovery 
operations from offline media.

Rollbacks are destructive by nature, which means the entire contents of the file 
system are overwritten during a rollback operation.

rollover The process of backing up a snapshot to a conventional backup medium such as tape. 
Whether or not the snapshot is retained on disk depends on the snapshot policy.

root The highest level of the system directory structure.

S
save set A group of files or a file system that is backed up on storage media.

save set ID An internal identification number assigned to a save set.

save set recover To recover data by specifying save sets rather than by browsing and selecting files or 
directories.

save set status An attribute that indicates whether a save set is browsable, recoverable, or recyclable. 
The save set status also indicates whether the save set was successfully backed up.

server See NetWorker server and Console server.
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server index See client file index.

serverless backup A backup method that uses a proxy client to move the data from primary storage on 
the application server host to secondary storage on another host. Serverless backups 
free up resources on the application server by offloading the work of processing 
snapshots to a secondary host.

service port A port used to listen for backup and recover requests from clients through a firewall.

shadow copy A point-in-time copy of data created during an instant backup. A shadow copy is 
created by interaction between a requestor and the Shadow Copy infrastructure at a 
specific point in time. See also Volume Shadow Copy Service (VSS).

shadow copy set A complete roadmap of what was backed up at a single instant in time. The shadow 
copy set contains information about the writers, their components, metadata, and the 
volumes. A backup components metadata document containing that information is 
created and returned to the requestor after the snapshot is complete. Networker uses 
this document with the corresponding saveset at recover time.

shadow copy
technology

A defined and standard coordination between business application, file system, and 
backup application that allows a consistent copy of application and volume data to 
exist for replication purposes.

skip A backup level in which designated files are not backed up.

snap clone An exact copy of a snap set data backup. The clone operation is an archive operation 
without the deletion of the source data. A new snap ID is assigned to the cloned copy.

snap ID Also known as a snapid, a unique 64-bit internal identification number for a snap set.

snap set The group of files, volumes, or filesystems from a single client, describing the 
collection of data for which a point-in-time copy is created on an external disk 
subsystem, such as a storage array.

snapshot Also known as a shadow copy, a snapshot is a point-in-time copy of data created 
during an instant backup.

snapshot expiration
policy

The policy that determines how long snapshots are retained before their storage 
space is made available for the creation of a new snapshot.

snapshot policy A set of rules that control the lifecycle of a snap set. The snapshot policy specifies the 
frequency of snapshots, and how long snapshots are retained before recycling.

snapshot retention
policy

The policy that determines how many PIT copies are retained in the media database 
and thus are recoverable.

ssid See save set ID.

staging Moving data from one storage medium to a less-costly medium, and later removing 
the data from its original location.

stand-alone device A storage device that contains a single drive for backing up data. 

storage device The hardware that reads and writes data during backup, recovery, or other 
NetWorker operations. 
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storage node A host that has a storage device and the NetWorker storage node software installed. 
A storage node’s backup operations are controlled by the NetWorker server.

V
volume 1. The physical storage medium, such as magnetic tape, optical disk, or file system to 

which backup data is written.

2. An identifiable unit of data storage that may reside on one or more host disks.

volume ID An internal identification that NetWorker software assigns to a backup volume.

volume mount point A disk volume that is grafted into the namespace of a host disk volume. This allows 
multiple disk volumes to be linked into a single directory tree, and a single disk or 
partition to be linked to more than one directory tree.

volume name The name assigned to a backup volume when it is labeled. See also label.

volume pool See pool.

Volume Shadow Copy
Service (VSS)

A Microsoft technology that creates a point-in-time shadow copy of a disk volume. 
NetWorker software backs up data from the shadow copy. This allows applications to 
continue to write data during the backup operation, and ensures that open files are 
not omitted.

VSS See Volume Shadow Copy Service (VSS).

VSS component A subordinate unit of a writer.

W
writer A database, system service, or application code that provides metadata document 

information about what to back up and how to handle VSS components and 
applications during backup and recovery operations. A Writer provides information 
to requestors to ensure that application data is consistent, application files are closed 
and ready for a slight pause to make a Shadow Copy.
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